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chapter 1

Getting Started with Plug-Ins
Plug-Ins are special-purpose software that add 
additional signal processing functionality to 
Pro Tools. 

The DigiRack plug-ins included with Pro Tools 
provide a comprehensive set of digital signal 
processing effects that include EQ, dynamics, 
delay, and other essential functions.

There are three formats of plug-ins: 

• TDM plug-ins (real-time)

• RTAS plug-ins (real-time)

• AudioSuite plug-ins (non-real-time, file-based 
processing)

TDM Plug-Ins
(TDM Systems only)

TDM plug-ins function as track inserts, are ap-
plied to audio during playback, and process au-
dio non-destructively in real time. TDM plug-
ins are designed for use on TDM-based Pro Tools 
systems, and rely on the processing power of 
Digidesign DSP cards. 

The number and variety of TDM plug-ins that 
you can use simultaneously in a session are lim-
ited only by the amount of DSP available. You 
can increase available DSP by installing addi-
tional MIX Farm or DSP Farm cards in your 
computer. This power-on-demand aspect is a 
significant advantage of TDM-based systems.
RTAS Plug-Ins 

RTAS (Real-Time AudioSuite) plug-ins provide 
features and functionality similar to their TDM 
counterparts, but unlike TDM plug-ins, they rely 
on and are limited by the processing power of 
your computer. The more powerful your com-
puter, the greater the number and variety of 
RTAS plug-ins that you can use simultaneously. 

Because of this dependence on the CPU or host 
processing, the more RTAS plug-ins you use con-
currently in a session, the greater the impact on 
other aspects of system performance such as 
available track count, edit density, and automa-
tion latency. 

RTAS plug-ins can be used on both TDM and 
non-TDM-based Pro Tools systems. 

AudioSuite Plug-Ins 

Non-real-time AudioSuite plug-ins are not used 
during playback, but are instead used to process 
audio files on disk, creating new, rewritten audio 
files with the effect permanently applied. Audi-
oSuite plug-ins can be used on all Pro Tools sys-
tems.
Chapter 1: Getting Started with Plug-Ins 1
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Allocating Additional Memory 
to DAE
(Macintosh Only)

If you plan to use a large number of TDM plug-
ins in addition to the DigiRack TDM plug-ins in-
cluded with Pro Tools, allocating additional 
memory to DAE will help ensure reliable system 
performance. 

If enough RAM is available in your computer, al-
locate 1-2 megabytes of additional RAM to DAE 
for each non-DigiRack plug-in installed on your 
system.

To allocate additional memory to DAE:

1  Start Pro Tools so that DAE can calculate its 
basic memory allocation. 

2  Go to the Finder and choose About This Com-
puter from the Apple menu.

3  If you have 3 megabytes or more of memory 
available (as indicated in the Largest Unused 
Block portion of this window), go to step 4. If 
you have less than 3 megabytes of free memory 
(3,000k), stop here: Do not allocate additional 
memory to DAE unless you install additional 
RAM in your computer. 

4  Quit Pro Tools. 

5  Open the DAE folder inside your System 
Folder, select DAE, and choose Get Info from the 
Finder’s File menu. 

6  Choose Memory from the Show menu.
DigiRack Plug-Ins Guide
7  Enter the desired amount of memory above the 
minimum requirement in the Preferred Size field. 
For example, if the Preferred Size field currently 
says “30410k” and you wish to allocate an addi-
tional 3 megabytes of memory (1 megabyte 
equals 1024 kilobytes), enter “33410” into the 
Preferred Size field.

8  Close the Get Info dialog. 

The next time you start Pro Tools, DAE will use 
this new memory allocation.

Allocating additional memory to DAE



                 
chapter 2

Working with Real-Time Plug-Ins
Real-time plug-ins process audio non-destruc-
tively in real time. They do not alter the original 
source audio, but only apply their effect during 
playback. 

There are two formats of real-time plug-ins:

TDM Plug-Ins Rely on the processing power of 
Digidesign DSP cards. TDM plug-ins run only on 
TDM-equipped Pro Tools systems. 

RTAS Plug-Ins Rely on the processing power of 
your computer. RTAS plug-ins run on TDM and 
non-TDM-equipped Pro Tools systems.

Processing Power 
Requirements of TDM and 
RTAS Plug-Ins
TDM and RTAS plug-ins differ in their process-
ing power requirements.

TDM Plug-Ins

Each real-time TDM plug-in in a Pro Tools ses-
sion uses a portion of your system’s total avail-
able DSP resources. Since these DSP resources re-
side on the cards that make up your particular 
Pro Tools hardware configuration, the amount 
of DSP available depends entirely on the num-
ber and type of DSP cards in your system. 
You can add more mixing and processing power 
to your system by installing additional DSP 
cards, provided you have unused PCI expansion 
slots in your computer or use a Digidesign-ap-
proved Expansion Chassis.

The System Usage window (Windows > Show 
System Usage) shows how much DSP is available 
on your system and how it is currently being 
used. For more information on the System Us-
age window, see the Pro Tools Reference Guide.

System Usage window

See Appendix A, “DSP Requirements for 
TDM Plug-Ins” for the number of instances 
of each DigiRack TDM plug-in that can be 
powered by a single DSP chip. DSP usage 
differs according to card type.
 Chapter 2: Working with Real-Time Plug-Ins 3
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DSP Sharing Between TDM Plug-Ins

Digidesign’s MultiShell II technology allows dif-
ferent types of TDM plug-ins to share the same 
DSP chip at the same time. This allows you to si-
multaneously use a greater variety of plug-ins by 
efficiently managing the DSP available on each 
chip in your system.

In order to take advantage of this capability, 
plug-ins must be MultiShell II compatible. All 
DigiRack TDM plug-ins with the exception of 
Direct Connect are MultiShell II compatible. 

Some third-party plug-ins may not be Multi-
Shell II compatible. To check compatibility, 
contact the developer. 

RTAS Plug-Ins

RTAS plug-ins rely on and are limited by the pro-
cessing power of your computer’s CPU. The 
more RTAS plug-ins you use concurrently in a 
session, the greater the impact it will have on 
other aspects of your system’s performance, 
such as maximum track count, the density of 
edits possible, and latency in automation and 
recording.

The CPU meter in the System Usage window 
(Windows > Show System Usage) shows how 
much of your computer’s processing power is 
currently being used by Pro Tools, and how 
much is still available.

For more information on the System Usage 
window, see the Pro Tools Reference Guide.
DigiRack Plug-Ins Guide
Improving RTAS Plug-In Performance

You can increase the number of RTAS plug-ins 
your system can use concurrently by increasing 
the Hardware Buffer Size and CPU Usage Limit 
parameters.

These parameters determine how much of your 
computer’s processing power is dedicated to 
running RTAS plug-ins and other host process-
ing tasks. 

To improve RTAS plug-in performance:

1  Choose Setups > Hardware. 

2  From the H/W Buffer Size pop-up, select the 
desired hardware buffer size.

If you are using many RTAS plug-ins con-
currently, setting the Hardware Buffer Size 
and CPU Usage Limit parameters too high 
may have a negative impact on on-screen 
performance tasks such as metering, fader 
movement, and automation accuracy.

Choosing the CPU Usage Limit



                   
3  From the CPU Usage Limit pop-up, select the 
percentage of CPU power you want to dedicate 
to RTAS plug-ins and host processing.

4  Click OK.

Delay in Digital Signal 
Processing
(TDM Plug-Ins Only)

DSP processing in digital audio systems incurs 
signal delay of varying amounts. Such delays 
can vary from as short as several microseconds 
to as long as several milliseconds, depending on 
the type of processing applied. 

Delays are a matter of concern only if you use a 
real-time TDM plug-in on one channel of a 
multi-channel signal but not the others. This 
can cause the channels to be slightly out of 
phase. 

If you are working with mono tracks, or are pro-
cessing all channels with the same plug-ins, 
these signal delays should not be a matter of 
concern.

For more information on the Hardware 
Buffer Size and CPU Usage Limit parame-
ters, see the Pro Tools Reference Guide.

See Appendix B, “DSP Delays Incurred by 
TDM Plug-Ins” for information on delays 
inherent in specific DigiRack TDM plug-
ins. See also the Pro Tools Reference Guide 
for a guide to calculating DSP-induced de-
lays.
Compensating with TimeAdjuster

You can compensate for TDM plug-in-induced 
delays by using the TimeAdjuster plug-in. This 
plug-in allows you to apply a specific number of 
samples of delay to the signal path of a Pro Tools 
track. TimeAdjuster provides settings files that 
apply the correct compensation time in samples 
for delay introduced by one or more plug-ins. 
See “TimeAdjuster” on page 39.

Plug-Ins as Inserts
Real-time plug-ins are available as in-line inserts 
on audio tracks, auxiliary inputs, and master 
faders. A maximum of 5 real-time plug-ins can 
be used per track.

When more than one insert is used on a track, 
they process the audio in series, each effect be-
ing added to the previous one, from top to bot-
tom in the Mix window. 

Inserts can be used in two ways:

On single tracks An insert can be applied to an 
individual audio track or auxiliary input using 
the Insert Selector on that track.

With in-line inserts, you control the level of ef-
fect by adjusting the controls of the plug-in.

As shared resources An insert can be used as a 
shared resource in a send-and-return arrange-
ment by bussing signals from several tracks to 
an auxiliary input, and applying the insert to 

If you are using both TDM and RTAS plug-
ins on the same track, RTAS plug-ins must 
occur first in the signal chain, followed by 
TDM plug-ins. You cannot place TDM 
plug-in inserts before RTAS plug-in inserts.
 Chapter 2: Working with Real-Time Plug-Ins 5
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the auxiliary input track. With such an arrange-
ment, you can control the send level for each 
track and the overall level of the effect can be 
controlled from the auxiliary input track. 

Shared arrangements allow you to make more 
efficient use of your system’s processing power. 

Pre-Fader Operation

Real-time plug-ins function as pre-fader inserts, 
meaning that their input levels are not affected 
by a track’s volume fader. 

Clipping can sometimes occur on tracks re-
corded at high amplitude. Watch on-screen me-
tering to identify clipping if it occurs. To pre-
vent clipping, avoid inserting the plug-in 
directly onto an audio track. Instead, insert the 
plug-in on an auxiliary input and attenuate the 
level of audio routed to it. 

Mono, Multi-Mono, and Multi-
Channel Plug-Ins

Plug-ins can be used in mono, multi-mono, or 
multi-channel formats, depending on the type 
plug-in and whether the destination is a mono 
or multi-channel track.

On TDM systems, RTAS plug-ins can be in-
serted on audio tracks only. For auxiliary 
inputs or master faders, use TDM plug-ins.
DigiRack Plug-Ins Guide
In general, when working with stereo and 
greater-than-stereo tracks, use multi-channel 
plug-ins. If a multi-channel version of a plug-in 
is not available, use a multi-mono version.

Mono Plug-Ins Are designed for use on mono 
tracks. Some mono plug-ins (such as Mod Delay) 
allow you to generate a stereo output from a 
mono channel. Inserts that occur on a track af-
ter a stereo insert are used in stereo as well.

Multi-Mono Plug-Ins Are designed for use on ste-
reo or greater multi-channel tracks when a 
multi-channel version of the plug-in is not 
available. Parameters for all channels are linked 
by default so that you can adjust them in tan-
dem. You can unlink parameter controls for in-
dependent adjustment using the Master Link 
button. See “Linking and Unlinking Controls 
on Multi-Mono Plug-ins” on page 11.

Multi-Channel Plug-Ins Are designed for use on 
stereo and greater-than-stereo multi-channel 
tracks. On greater-than-stereo multi-channel 
tracks, the parameters for all channels are gener-
ally ganged together.

Plug-in formats



                        
Inserting Plug-Ins on Tracks
To use a real-time plug-in in a Pro Tools session, 
insert it on a track. Before doing so, make sure 
the Inserts View is shown in the Mix window.

To show inserts in the Mix window:

■ Choose Display > Mix Window Shows > In-
serts View.

To insert a plug-in on a track:

■ Click the Insert Selector on the track and se-
lect the plug-in that you want to use. 

To remove an insert from a track:

■ Click the Insert Selector and choose No Insert.

Plug-In window (multi-channel Compressor shown)

Removing a plug-in

Click here
Moving and Duplicating Inserts

You can move or duplicate a plug-in insert by 
dragging it to a different position on the same 
track or a different track. Inserts that are moved 
or duplicated retain their original settings and 
automation.

To move an insert:

■ Drag the insert to the desired location.

To duplicate an insert:

■ Option-drag (Macintosh) or Alt-drag (Win-
dows) the insert to the desired location. The du-
plicated plug-in retains its original settings and 
automation.

Moving a plug-in

Dragging an insert on top of an existing in-
sert will replace it.
 Chapter 2: Working with Real-Time Plug-Ins 7
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The Plug-In Window
The Plug-In window appears whenever you click 
the Insert button on a track. This floating win-
dow allows you to edit the parameters of any 
real-time plug-in insert in use on a track.

Plug-In window (mono 1-band EQ shown)

Plug-In window (multi-mono 1-band EQ shown)

 Insert
selector

Settings menu

Track selector

Librarian menu

Insert Position
selector

Plug-In selector

Effect bypass

Compare

Enable
Automation

Insert button
Automation Safe

Convert Plug-In

Target button

Phase Invert

Channel selector

Link Enable buttons

Master Link button
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Settings menu Allows you to copy, paste, save, 
and import plug-in settings.

Track Selector Accesses any non-MIDI track in 
your session.

Librarian Menu Recalls settings files saved in the 
plug-in’s root settings folder or in the current 
session’s Settings folder. See “Using the Librar-
ian” on page 13.

Insert Position Selector Accesses any insert on 
the current track.

Key Input Selector Allows you to select audio on 
a particular input or bus and route it to trigger 
the plug-in. This menu only appears on plug-ins 
that feature side-chain processing. Key inputs 
are monophonic.

Plug-In Selector Allows you to select any real-
time plug-in installed in the DAE Plug-Ins 
folder.

Compare Toggles between the original saved 
plug-in setting and any changes you have made 
to it so you can compare them.

Effect Bypass Disables the currently displayed 
plug-in. This allows you to compare the track 
with and without the effect.

Plug-In window (multi-channel Compressor shown)

LFE enable

Phase invert buttons



                            
Enable Automation Parameters Allows you to en-
able individual plug-in parameters for automa-
tion recording. See “Automating Plug-Ins” on 
page 12.

Automation Safe When enabled, prevents exist-
ing plug-in automation from being overwritten.

Convert Plug-In Allows you to convert the insert 
from a TDM plug-in to an RTAS plug-in of the 
same type (or vice-versa). This feature can only 
be used on plug-ins that are available in both 
TDM and RTAS formats.

Target Button When multiple Plug-In windows 
are open, clicking this button selects that plug-
in as the target for any computer keyboard com-
mands.

Phase Invert Button Inverts the phase polarity of 
the input signal.

Channel Selector Accesses a specific channel 
within a multi-channel track for plug-in param-
eter editing. This menu appears only on multi-
mono plug-ins inserted on tracks with more 
than one channel. Shift-clicking this selector 
opens a separate Plug-In window for each chan-
nel of the multi-channel track on which the 
plug-in is inserted.

Master Link Button When enabled, links the pa-
rameter controls on all channels of a multi-
mono plug-in so that they can be adjusted in 
tandem.

Link Enable Buttons Allow you to selectively 
link the parameter controls of specific channels 
of a multi-mono plug-in. Each square represents 
a speaker channel. The Master Link button must 
be disabled to use the Link Enable buttons. See 
“Linking and Unlinking Controls on Multi-
Mono Plug-ins” on page 11.
LFE Enable Enables plug-in processing of the 
LFE (low frequency effects) channel on a 5.1, 
6.1, and 7.1-format multi-channel track. To dis-
able LFE processing, deselect this button. For 
more information on the LFE channel, refer to 
the Pro Tools Reference Guide.

Using the Plug-In Window

To select a different plug-in on the same track:

■ Click the Insert Selector and choose a plug-in 
from the pop-up menu.

To choose a different track:

■ Click the Track Selector and choose a track 
from the pop-up menu.

Choosing a plug-in from the Plug-In window

Choosing a track from the Plug-In window
 Chapter 2: Working with Real-Time Plug-Ins 9
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To bypass a plug-in:

■ Click the Plug-In window’s Bypass button.

– or –

■ Command-click (Macintosh) or Control-click 
(Windows) the plug-in’s Insert button in the 
Mix window. 

Opening Multiple Plug-In Windows

To reduce screen clutter, Pro Tools normally dis-
plays a single Plug-In window from which you 
can edit the parameters of any plug-in in a ses-
sion. If you want, however, you can open addi-
tional Plug-In windows for specific plug-ins. 

Once you begin working with multiple Plug-In 
windows, you will need to click the Target but-
ton on the plug-in whose parameters you want 
to edit using keyboard commands.

To open a Plug-In window for a specific plug-in:

■ In the Mix window, Shift-click the Insert but-
ton of the desired plug-in. 

When a plug-in insert is bypassed, the In-
sert Selector in the Mix window changes its 
color to blue for easy visual reference. If 
some, but not all channels of an unlinked 
multi-mono plug-in are bypassed, the Insert 
Selector appears half blue and half black.

Bypass states indicated by color

bypassed (blue)

some channels bypassed (half blue)

unbypassed (black)
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To open Plug-In windows for each channel of a 
multi-mono plug-in:

■ Option-click (Macintosh) or Alt-click (Win-
dows) the Channel Selector in the Plug-In win-
dow of the desired plug-in. 

To close all currently open Plug-In windows:

■ Option-click (Macintosh) or Alt-click (Win-
dows) the close box of any currently open Plug-
In window. 

Editing Plug-In Parameters
You can edit plug-in parameters by dragging the 
parameter’s slider or by typing a value into the 
parameter’s text box.

To edit a plug-in parameter:

1  Begin audio playback so that you can hear pa-
rameter changes in real time.

2  Adjust the parameters of the plug-in for the ef-
fect you want.

Keyboard Shortcuts

■ For finer adjustments, Command-drag (Mac-
intosh) or Control-drag (Windows) the control.

■ To return a control to its default value, Op-
tion-click (Macintosh) or Alt-click (Windows) 
the control. 

Keyboard Input for Plug-In 
Parameters

You can use your computer keyboard to edit 
plug-in parameters. If multiple plug-in windows 
are open, click the Target button on the plug-in 
whose parameters you want to edit.



To edit parameters with a keyboard:

◆ Click the parameter text field that you want to 
edit. Type the desired value.

◆ In fields that support values in kilohertz, typ-
ing “k” after a number value will multiply the 
value by 1000. (If you want to enter a value of 
8000, type “8k”).

◆ To increase a value, press the Up Arrow on 
your keyboard. To decrease a value, press the 
Down Arrow on your keyboard.

◆ Press Enter on the numeric keyboard after typ-
ing a value to input the value (without leaving 
the selected parameter field).

◆ Press Return (Macintosh) or Enter on the al-
pha keyboard (Windows) to enter the value and 
leave keyboard editing mode.

To move downward through the different pa-
rameter fields, press the Tab key. To move up-
wards, press Shift+Tab. 

Linking and Unlinking Controls on 
Multi-Mono Plug-ins

When a multi-mono plug-in is used on a multi-
channel track, the controls are normally linked. 
Adjusting the Gain parameter on one channel, 
for example, will adjust it for all channels.

If necessary, you can unlink plug-in controls on 
specific channels of a track and edit them inde-
pendently. You can also selectively link the con-
trols of specific channels.

Channel Selector and Link controls

Channel selector

Link Enable buttons

Master Link button
To unlink controls on a multi-mono plug-in:

■ Deselect the Master Link button.

To access controls for a specific channel:

■ Select the desired channel from the Channel 
Selector.

To link the controls of specific channels:

1  Deselect the Master Link button if it is not al-
ready deselected.

2  Click the Link Enable buttons for the chan-
nels whose controls you want to link.

Using a Key Input for Side 
Chain Processing
Some plug-ins, such as the Compressor, Limiter, 
Gate, and Expander/Gate feature side-chain pro-
cessing capabilities. Side-chain processing al-
lows you to trigger a plug-in from a separate ref-
erence track or external audio source. The source 
used for triggering is referred to as the key input. 
Key inputs are monophonic.

A typical use for this feature is to control the dy-
namics of one audio signal using the dynamics 
of another signal (the key input). A kick drum 
track, for example, can be used to trigger gating 
of a bass track to tighten it up. A rhythm guitar 
track can be used to gate a keyboard pad, and so 
on. 

RTAS plug-ins do not provide side-chain 
processing when used on TDM-based sys-
tems.
 Chapter 2: Working with Real-Time Plug-Ins 11
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Key Input Filters

Some plug-ins feature key high-pass and low-
pass filters. These controls allow you to define a 
specific frequency range in the key input signal 
with which to trigger the plug-in effect. A com-
mon production technique is to use these con-
trols to filter a drum track so that only specific 
high frequencies (a hi-hat, for example) or low 
frequencies (a tom or a kick, for example) trigger 
the effect.

To use a key input for side chain processing:

1  From the Key Input menu, choose the in-
put/bus carrying the audio you want to use to 
trigger the plug-in.

2  Click External Key to activate side chain pro-
cessing.

3  To hear the audio source you have selected to 
control side chain input, click Key Listen.

4  To filter the key input so that only specific fre-
quencies trigger the plug-in, use the Key HPF 
and Key LPF controls (if available) to select the 
desired frequency range.

5  Begin playback. The plug-in uses the in-
put/bus that you chose as a key input to trigger 
its effect.

Choosing a key input
DigiRack Plug-Ins Guide
6  Adjust the plug-in’s Threshold parameter (if 
available) to fine tune key input triggering.

7  Adjust other parameters to achieve the desired 
effect.

Automating Plug-Ins
You can automate changes to plug-in parame-
ters. Since Pro Tools creates a separate playlist 
for each plug-in parameter that you automate, 
you can later edit and modify each automated 
parameter individually. This allows you to build 
up complex automation in stages.

To enable automation:

1  Open the Plug-In window for the plug-in you 
want to automate.

2  Click the Automation button, choose the pa-
rameters to automate, and click Add, then OK.

– or –

To create automation for a stereo plug-in 
with separate controls for each channel, 
(such as Mod Delay), record the automation 
for one channel then copy and paste it to the 
other channel.

Plug-In automation dialog



Command-Control-Option-click (Macintosh) or 
Control-Alt-Start-click (Windows) the parame-
ter’s slider or knob and choose Enable Automa-
tion for each parameter you want to automate.

To record automation:

1  In the Automation Enable window, make sure 
that plug-in automation is write-enabled.

2  On the track with the insert, choose an auto-
mation mode. For an initial pass, choose Auto 
Write.

3  Click Play to begin writing automation, and 
move the controls you want to automate.

4  When you have finished, click Stop.

After the initial automation pass, you can write 
additional automation to the track without 
completely erasing the previous pass by choos-
ing Auto Touch mode or Auto Latch mode. 
These modes add new automation only when 
you actually move the control for that parame-
ter.

Enabling plug-in automation

Automation Enable window
Record Safing Plug-In Automation

If you are satisfied with the automation re-
corded for a plug-in, you can use the Automa-
tion Safe button to ensure that you don’t inad-
vertently overwrite it.

To record safe automation for a plug-in:

1  Open the Plug-In window for the plug-in.

2  Select the Automation Safe button.

To disable automation record safing for a plug-in:

■ Deselect the Automation Safe button on the 
desired plug-in.

Using the Librarian 
The Settings Librarian makes it easy to create 
your own library of plug-in settings. Using the 
Librarian and Settings pop-up menus, you can 
copy, paste, save, and import these settings from 
plug-in to plug-in, or from session to session.

For more information on creating and edit-
ing automation, see the Pro Tools Reference 
Guide.

Librarian menu
 Chapter 2: Working with Real-Time Plug-Ins 13
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Once you create and save settings files to disk 
(and tell Pro Tools where to find them by assign-
ing their root folder) they will appear in the Li-
brarian menu.

The Settings Menu

The Settings menu allows you to save, copy, 
paste, and manage plug-in settings files. 

Settings menu commands:

Save Settings Saves the current settings. This 
command overwrites any previous version of 
the settings. The setting then appears in the Li-
brarian menu. 

Save Settings As Saves the current settings un-
der a different name or in a different location.

Copy Settings Copies the current settings. You 
can then apply these settings to the same type of 
plug-in on a different track by choosing the 
track in the Plug-In window and pasting the set-
tings with the Paste Settings command. 

Settings menu
DigiRack Plug-Ins Guide
Paste Settings Pastes settings copied with the 
Copy Settings command.

Import Settings Imports a settings file from a lo-
cation other than the Root Settings folder or Ses-
sion folder. 

Delete Current Settings File Permanently de-
letes the current settings file from disk.

Lock Settings FIle Prevents the current settings 
from being overwritten by the Save command. 
If you attempt to save parameter changes, you 
will be required to save them using a different 
name or disk location.

Set As User Default Defines the current settings 
as the User Default for a specific plug-in.

Settings Preferences

The sub menus that appear here are for choos-
ing preferences for saving and importing plug-
in settings. They include:

Set Plug-In Default To Sets the default setting to 
either Factory Default (the standard default set-
ting for that plug-in) or User Default (your cus-
tom setting).

Save Plug-In Settings To Selects the folder where 
plug-in settings are saved. If you choose Session 
Folder, the settings are saved in a folder named 
“Plug-In Settings” within the current session 
folder. If you choose Root Settings Folder, the 
settings are saved in the folder you specified 
with the Set Root Settings Folder command.

Set Root Settings Folder Selects a source or root 
folder for saving and importing settings. Use 
this command only if you want to choose a lo-
cation other than DAE’s Plug-In Settings folder.



Choosing a Destination for 
Settings

Before you save settings, select their destination 
folder. 

To select a destination folder: 

■ From the Settings pop-up menu, choose Set-
tings Preferences > Save Plug-In Settings To, and 
choose Session Folder or Root Settings Folder.

If you choose Root Settings folder, Pro Tools 
saves to the Plug-In Settings folder within the 
DAE Folder. 

To select a different Root Settings folder:

1  From the Settings pop-up menu, choose Set-
tings Preferences > Set Root Settings Folder.

2  Select the folder you want to use as your Root 
folder and click Select “(your folder’s name).” 

Managing Settings

Use the Settings pop-up menu to manage set-
tings.

To save a setting: 

1  Choose Save Settings from Settings pop-up 
menu.

2  Type a name and click OK. The setting now 
appears in the Librarian menu. 

When a multi-mono plug-in is unlinked, 
importing, copying, pasting, or bypassing 
settings affects only the currently selected 
channel. To apply an operation to all chan-
nels of the plug-in, hold down the Option 
(Macintosh) or Alt (Windows) key while 
performing the command.
To load a previously saved setting:

■ Choose the setting from the Librarian pop-up 
menu.

To import a setting: 

1  Choose Import Settings from the Settings pop-
up menu.

2  Locate the settings file you want to import 
and click Open. Pro Tools loads the setting and 
copies it to the root destination folder.

To copy a setting: 

■ Choose Copy Settings from the Settings pop-
up menu.

To paste a setting: 

1  Open the destination plug-in.

2  Choose Paste Settings from the Settings pop-
up menu.

To create a custom User Default setting: 

1  Create and save a setting.

2  Choose Set As User Default from the Settings 
pop-up menu. 

To make a plug-in default to your custom setting: 

■ From the Settings pop-up menu, choose Set 
Plug-In Default To > User Setting.

Editing Settings on Unlinked Multi-
Mono Plug-ins

When a multi-mono plug-in is unlinked, im-
porting, copying, pasting, or bypassing settings 
affects only the currently selected channel. 
 Chapter 2: Working with Real-Time Plug-Ins 15
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To apply an operation to all channels of an 
unlinked plug-in:

■ Hold down the Option key (Macintosh) or Alt 
key (Windows) while performing the command.

Creating Subfolders for Settings

To make it easier to find specific types of set-
tings, you can subdivide settings files by creat-
ing subfolders for them. 

To create a settings subfolder:

1  From the Settings pop-up menu, choose Save 
Settings.

2  Click the New Folder button and type a name 
for the subfolder.

3  Name the setting and click Save. The setting is 
saved within the subfolder.

Librarian menu with subfolders for settings
DigiRack Plug-Ins Guide



chapter 3

Working with AudioSuite Plug-Ins
AudioSuite plug-ins differ from TDM and RTAS 
plug-ins in that they are not used non-destruc-
tively in real time, but are instead used to pro-
cess and modify audio files on disk. Depending 
on how you configure a non-real-time Audio-
Suite plug-in, it will either alter the original 
source audio file or create an entirely new audio 
source file. 

AudioSuite plug-ins are accessed through the 
AudioSuite menu.

AudioSuite Plug-Ins 

Compressor Processes audio with compression.

LImiter Processes audio with limiting.

Gate Processes audio with gating.

Expander Gate Processes audio with expander-
gating.

 AudioSuite menu 
De-esser Processes audio with de-essing to re-
move sibilance.

1-band EQ II Processes audio with hi-pass, lo-
shelf, hi-shelf, lo-pass or peak EQ filters, in a 1-
band or 4-band module.

4-band EQ II Processes audio with hi-pass, lo-
shelf, hi-shelf, lo-pass or peak EQ filters, in a 1-
band or 4-band module.

Invert Inverts phase (polarity).

Duplicate Creates a new, continuous source au-
dio file (and region) from the selection.

Short Delay Adds up to 18 ms of delay.

Slap Delay Adds up to 157 ms of delay.

Medium Delay Adds up to 366 ms of delay.

Long Delay Adds up to 3658 ms of delay.

Normalize Uniformly adjusts all levels in a re-
gion or regions to a user-definable level, using 
the loudest peak in the audio file as the refer-
ence.

Gain Allows variable gain (volume) change, in 
decibels or percentage before clip.

Reverse Rewrites selected audio in reverse

DC Offset Removal Recognizes and removes DC 
offset from audio files.
Chapter 3: Working with AudioSuite Plug-Ins 17
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Signal Generator Generates audio tones for 
equipment calibration purposes.

Time Compression/Expansion Changes an audio 
file’s duration with or without changing its 
pitch.

Pitch Shift Changes an audio file’s pitch with or 
without changing its duration.

The AudioSuite Window
When you choose a plug-in from the 
AudioSuite menu, the AudioSuite window ap-
pears. This floating window allows you to access 
and edit the parameters for any non-real-time 
AudioSuite plug-in. 

Plug-In Selector

This menu allows you to select any AudioSuite 
plug-in installed in your Plug-Ins folder.

 AudioSuite window

Plug-In Selector menu 

File mode
selector

Plug-In
selector

Bypass

Process
mode

Selection
reference

Process
button

Preview
button

Use in Playlist 
button
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Selection Reference

This menu aims the selected process at either re-
gions selected in an audio track/playlist, or at re-
gions selected in the Audio Regions List. 

When you select a region on-screen (in either a 
track/playlist or the Audio Regions List) 
Pro Tools normally selects both occurrences of 
the region. Since you may not want to process 
both, this menu provides a convenient means of 
limiting the AudioSuite process to regions se-
lected in one or the other. 

Playlist Applies AudioSuite processing only to 
regions currently selected in tracks/playlists in 
the Edit window. Processing will not be applied 
to regions in the Audio Regions List.

Region List Applies AudioSuite processing only 
to regions currently selected in the Audio Re-
gions List. Processing will not be applied to re-
gions located in tracks and playlists in the Edit 
window.

Use in Playlist Button

This button determines whether the AudioSuite 
plug-in will replace all instances of the selected 
regions everywhere in the session, or only the 
occurrences of the regions that are currently se-
lected. 

Use In Playlist Off When Use in Playlist is dis-
abled, only the currently selected region will be 
replaced. 

Selection Reference pop-up menu 

Use in Playlist button



Use In Playlist On, Reference = Region List 
When Use in Playlist is enabled and the Selec-
tion Reference pop-up menu is set to Regions 
List, all copies of the selected region will be re-
placed everywhere in the session. 

Use In Playlist On, Reference = Playlist When 
Use in Playlist is enabled and the Selection Ref-
erence menu is set to Playlist, only regions se-
lected in tracks in the Edit window will be re-
placed. If the session includes other copies of 
the region used in other playlists, those copies 
of the original, unprocessed region will not be 
replaced. 

File Mode Selector

This menu allows you to select whether or not 
the AudioSuite plug-in will process the selected 
audio destructively or non-destructively, and 
how the original files will be modified.

There are three options:

Overwrite Processes the selected regions destruc-
tively, overwriting the original audio. Not all 
AudioSuite plug-ins can be used destructively. 

Create Individual Files Processes the selected re-
gions non-destructively, creating a new audio 
file for each region. The new audio files are 
added to the session, leaving the original source 
audio files in the Regions List unchanged. 

If the Selection Reference pop-up menu is set 
to Region List, the Use in Playlist button 
will automatically be disabled to ensure 
that you do not accidentally replace every 
occurrence of the region in a session.

File Mode pop-up menu
(Whether the processed audio is added to the 
current playlist or only to the Regions List, is de-
termined by the Selection Reference setting, as 
explained earlier.)

Create Continuous File Processes the selected re-
gions non-destructively and creates a new audio 
file consisting of the selected regions “glued” 
into a into a single, unbroken region. This mode 
is particularly useful if you are assembling a 
composite track from multiple takes. This mode 
is not available when the Selection Reference is 
set to Region List.

Process Mode Selector

If you have made a selection which includes 
multiple regions, this pop-up menu allows you 
to specify whether AudioSuite processing is per-
formed on a region-by-region, or entire-selec-
tion basis. 

Region by Region Analyzes each region in a se-
lection individually, rather than over the entire 
multi-region selection as a whole. 

Entire Selection Uses the entire selection for 
analysis. All regions will be analyzed and pro-
cessed relative to the entire selection.

The Create Continuous File option is not 
available with some time domain plug-ins. 
To achieve a similar result, use the Dupli-
cate plug-in to glue together regions pro-
cessed with these plug-ins.
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Track Process Mode Selector

If you have made a selection which includes re-
gions from multiple tracks, some AudioSuite 
plug-ins allow you to choose whether you want 
to perform processing on a track-by-track, or an 
all-tracks basis. 

This pop-up has the same effect as the Process 
Mode Selector, with one important distinction: 
the Process mode pop-up controls region pro-
cessing within each track. The Track Process 
Mode Selector, on the other hand, lets you 
choose to apply the current AudioSuite process 
to each track individually, or to all tracks collec-
tively. 

Peak On Each Track Analyzes each selected track 
individually. If you apply the Normalize plug-in 
to multiple tracks in Peak on Each Track mode, 
for example, each track will be Normalized with-
out regard to the other selected tracks.

Peak From All Tracks Uses all currently selected 
tracks for analysis. If you apply the Normalize 
plug-in to multiple tracks in Peak From All 
Tracks mode, for example, the tracks will be an-
alyzed as a single entity and regions will be nor-
malized relative to the peak level within all se-
lected tracks.

Preview

The Preview button allows you to audition the 
effect of a plug-in before you process the audio. 
By adjusting the plug-in parameters while you 
listen to this audio preview, you can fine-tune 
the effect. Not all AudioSuite plug-ins support 
this feature. 

Track Process Mode Selector
DigiRack Plug-Ins Guide
The Preview function routes audio to the spe-
cific outputs you have chosen with the Audition 
pop-up in the Outputs page of the I/O Setup di-
alog. Make sure you have configured this param-
eter correctly for your system or you may not be 
able to hear previewed audio.

Before you use Preview, be aware that: 

◆ The performance of the Preview function de-
pends on the speed of your CPU. Faster comput-
ers preview AudioSuite effects better than slower 
computers. 

◆ Regardless of how many tracks/regions are 
currently selected, the Preview button will audi-
tion only the first selected track.

◆ If you are using Region-by-Region processing 
mode, the Preview function will preview only 
the first region within a multi-region selection. 
To hear all selected regions, temporarily select 
Create Continuous File from the File Mode 
menu before previewing.

◆ The Preview function is affected by the Audi-
oSuite Buffer Size parameter (on the Processing 
page of the Pro Tools Preferences dialog). See 
“The AudioSuite Processing Preferences Dialog” 
on page 22.

Bypass

When Bypass is enabled, the selected audio is 
auditioned without AudioSuite processing. The 
Bypass button applies only to previewing. It 
does not affect actual AudioSuite processing. 

For more information on using the I/O 
Setup dialog to configure your system’s au-
dio outputs, refer to the Pro Tools Reference 
Guide.



Process

Clicking this button begins AudioSuite process-
ing of the selected audio. Processing can occur 
during playback (though it may take slightly 
longer). Processed files are auto-named with the 
region or audio file’s name plus an acronym for 
the chosen AudioSuite process. 

New files are written to the hard disk specified 
for that track in the Disk Allocation dialog, or to 
the same drive as the original file if the region is 
not currently on a track. See “Auto-File Naming 
of AudioSuite-Processed Audio” on page 21.

Multi-channel Processing

DigiRack AudioSuite plug-ins allow up to 48 
channels of audio to be processed simulta-
neously.

Undoing AudioSuite Processing

If you have processed an audio selection non-
destructively, the Undo and Redo commands al-
low you to undo the selected AudioSuite pro-
cess. You can undo/redo an AudioSuite process 
during audio playback. 

Auto-File Naming of AudioSuite-
Processed Audio

When new audio files are created as a result of 
AudioSuite processing, Pro Tools will auto-name 
these files according to the type of plug-in used. 
The name of the region determines the prefix, 
while the type of AudioSuite plug-in determines 
the suffix.

Undo is not available when a plug-in is con-
figured for destructive editing since the pro-
cess has already overwritten the source au-
dio file. 
Auto file-naming follows these rules:

◆ New regions are named beginning with the 
region name, followed by an abbreviation of the 
current AudioSuite process, followed by stan-
dard Pro Tools file and region numbering.

◆ If a plug-in’s File Mode pop-up is set to Over-
write, the original region’s name will not be 
changed. 

◆ If a plug-in’s File Mode pop-up is set to Create 
Individual Files, the resulting regions will have 
an abbreviated version of the plug-in name ap-
pended to them.

Other AudioSuite Parameters

In addition to the standard AudioSuite parame-
ters, there are a number of special-purpose con-
trols found on certain plug-ins:

Plug-In Librarian/Settings Menus The Settings 
and Librarian pop-up menus that appear in 
some AudioSuite plug-ins provide a means of 
saving, loading, copying, pasting and organiz-
ing custom plug-in settings files. See “Using the 
Librarian” on page 13.

Analyze Button Analyzes a selection without ac-
tually processing it. On the DigiRack Gain plug-
in, the Analyze feature allows you to determine 
the maximum peak level on a track at a specific 
gain value before you process the audio. 

Side Chain Input Selector Selects a track/bus to 
be used to trigger processing. In order to use this 
feature, the key input source audio must occur 
at the same time as the target audio. Side chain 
input is monophonic. See “Using a Key Input 
for Side Chain Processing” on page 11.
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The AudioSuite Processing 
Preferences Dialog
Before you begin using AudioSuite plug-ins, use 
the Preferences dialog (Setups > Preferences > 
Processing) to configure default AudioSuite pa-
rameters according to your needs. These param-
eters include the default dither setting, a dither 
on/off checkbox, and the AudioSuite buffer size 
parameter.

AudioSuite Dither When selected, dither is ap-
plied during certain AudioSuite processes (such 
as Normalize and Gain), using the dither algo-
rithm selected in the Dither Plug-In pop-up. 
Dither is most useful when working with low-
level files that contain a fade in or fade out. 

Dither Plug-in AudioSuite plug-ins always create 
files that inherit the session’s bit depth. The 
Dither Plug-In pop-up menu allows you to 
choose the dither algorithm used for dithering 
higher-bit source files during AudioSuite pro-
cessing. 

 Processing Preferences page
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Edit Settings Accesses options for the presently 
selected Default Dither plug-in. In the case of 
the Digidesign Dither plug-in, this allows you to 
turn noise shaping on or off. 

Bit Depth Selects the default bit depth used by 
the dither function during AudioSuite process-
ing. Bit depth can be set to 16-, 18-, 20-, or 24-
bit. 

AudioSuite Buffer Size Selects the size of 
Pro Tools memory buffer for processing and pre-
viewing AudioSuite plug-ins. Choices are Mini, 
Small, Medium, Large, or Jumbo. In general, 
choosing a smaller buffer speeds up AudioSuite 
previewing functions. Choosing a larger buffer 
speeds up AudioSuite processing of audio files. 

To configure the AudioSuite Buffer Size:

1  Choose Setups > Preferences. 

2  Click Processing.

3  Select an AudioSuite Buffer Size. Your choice 
will depend on whether you want to give prior-
ity to the length of the audio preview, or to the 
speed at which the Plug-in can process the se-
lected audio.

4  Click Done. 

Though the default setting will work well for 
most situations, you may want to set the buffer 
according to your current task: Before you audi-
tion an AudioSuite plug-in, set this buffer to 
Mini or Small. Then, when you are ready to pro-
cess a file, reset it to Large or Jumbo.

See “Noise Shaping” on page 38 for more 
information.

For an explanation of dither, See “Dither” 
on page 37.



TC/E Selects the Time Compression & Expan-
sion plug-in and default settings used when ed-
iting with the Scrub Trimmer.

Using AudioSuite Plug-Ins
AudioSuite plug-ins can be applied to whole re-
gions, partial regions, or selections that are 
made up of whole and partial regions across one 
or more tracks.

When audio selected in the Edit window in-
cludes partial regions, the regions will automat-
ically be split into two or more regions when 
they are processed. Processing will occur only 
on the selection, leaving other regions un-
changed. 

Only audio files on locally connected hard 
drives can be processed with AudioSuite plug-
ins. You cannot process audio files on remote 
hard drives over a network.

Selecting Tracks for AudioSuite 
Processing

Because AudioSuite processes are performed on 
the specific regions that you select, it is impor-
tant that you select only those regions you actu-
ally want to process. 

Selecting a region in the Audio Regions List will 
automatically select it in a track (if it currently 
resides on one). This is Pro Tools default behav-
ior. You can change this, however, using the Re-
gion Selection Follows Track Selection, and 

Processing a locked region will cause the re-
gion to become unlocked. For more informa-
tion about locked regions, refer to the 
Pro Tools Reference Guide.
Track Selection Follows Regions List Selection 
options in the Editing page of the Preferences di-
alog. See the Pro Tools Reference Guide for an ex-
planation of these Preferences.

Selecting Tracks for Delay or Reverb 
Processing

Because some AudioSuite effects such as delay 
and reverb add additional material to the end of 
the selected audio (a reverb tail or a delay tap), it 
is very important that you make a selection that 
is longer than the original source material so that 
the plug-in can write it into the audio file. 

If you select only the original material, without 
leaving additional space at the end, a reverb de-
cay or delay that occurs after the end of the re-
gion will be cut off. 

To accommodate for this, place the region in a 
track, and select the desired audio plus an 
amount of blank space at the end of the region 
equal to the amount of delay or reverb decay 
that you have added in the plug-in. The plug-in 
will then have space at the end of the region in 
which to write the final delay or decay. 

If you select more blank space than you need, 
you can remove it using the Trim tool after ap-
plying AudioSuite processing.

When processing a single audio channel 
with an AudioSuite plug-in, make sure that 
the plug-in is set to Mono mode (if avail-
able). 
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To process audio with an AudioSuite plug-in: 

1  Select the desired regions in the target track(s) 
and/or in the Audio Regions List. Shift-click to 
select multiple regions. Only regions that are se-
lected will be processed.

2  Choose the desired AudioSuite plug-in from 
the AudioSuite menu. 

3  Click the Preview button to begin playback of 
the selected material. 

4  Adjust the plug-in parameters to achieve the 
effect that you want. These settings will deter-
mine how the file is processed and what effect 
the processing will have on the original regions. 
Follow these guidelines:

◆ To process the selected region only in the 
track in which it appears, choose Playlist from 
the Selection Reference pop-up. Alternatively, if 
you want to process the selected region in the 
Audio Regions list only, choose Region List from 
this pop-up. 

◆ If you want to process and update every oc-
currence of the selected region throughout your 
session, enable the Use In Playlist button (and 
also choose Region List from the Selection Refer-
ence pop-up). Alternatively, if you do not want 
to update every occurrence of the selected re-
gion, deselect the Use In Playlist button.

◆ To configure the plug-in for destructive pro-
cessing, choose Overwrite Files from the File 
Mode pop-up menu. This will overwrite and 
permanently modify the original source audio 
files. 
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◆ Alternatively, to configure the plug-in for 
non-destructive processing, choose Create Indi-
vidual Files from the File Mode pop-up menu. 
This will create new audio files that have been 
processed with the AudioSuite Plug-in and leave 
the original source audio files untouched.

■ If you have selected multiple regions for pro-
cessing and want to create a new file that con-
nects and consolidates all of these regions 
together, choose Create Continuous File from 
the File Mode pop-up menu. 

1  Finally, when you are ready, click the Process 
button. The selected audio is processed accord-
ing to the settings you have specified. Pro Tools 
appends an acronym to the region’s name indi-
cating the AudioSuite process that has been ap-
plied. The new audio files then appear in your 
session.



chapter 4

DigiRack Real-Time TDM and RTAS Plug-Ins
EQ II
The DigiRack EQs included with Pro Tools fea-
ture a 1-band and a 4-band EQ. The 4-band EQ 
provides a wider range of control over the fre-
quency spectrum of an audio signal and thus re-
quires more DSP.

1-band EQ plug-in
 Adjusting EQ

A useful way to audition an EQ is to increase or 
decrease its gain several dB then sweep the fre-
quency up or down until you hear its effect. You 
can then make more precise adjustments to the 
settings.

4-band EQ plug-in
Chapter 4: DigiRack Real-Time TDM and RTAS Plug-Ins 25



26
EQ II Parameters

Input Controls the input gain of the EQ, allow-
ing you to prevent clipping. Since Pro Tools in-
serts are pre-fader, plug-ins used as inserts can 
cause clipping if their levels are boosted exces-
sively.

Phase Invert Inverts the phase (polarity) of the 
input signal, allowing you to change frequency 
response characteristics between multi-miked 
sources (a common technique for miking a gui-
tar cabinet), or to correct for miswired micro-
phone cables.

Type Allows you to select an EQ type (high-pass, 
low-shelf, peak, high-shelf or low-pass).

Freq Designates the center of the frequency re-
gion to be cut or boosted.

Gain Controls the amount that the selected fre-
quencies are cut or boosted. 

Q Sets the bandwidth of the Peak filter. Higher 
values represent narrower bandwidths. Lower 
numbers represent wider bandwidths. This pa-
rameter is only available on the Peak EQ.

Bypass Bypasses the EQ. The 4-Band EQ has in-
dividual Bypass buttons for each band (the black 
buttons with appropriate EQ curve icons), as 
well as the standard all-band Bypass button at 
the top of the Inserts/Sends Editor window.

 Phase Invert

 Bypass EQ band button on the 4-band EQ
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High Pass Filter Attenuates all frequencies be-
low the selected cutoff frequency setting at a 
rate of 12dB per octave while allowing all others 
above to pass through. For this reason, no gain 
control is available for this filter. High Pass fil-
ters can be useful for removing low frequency 
rumble or thinning out the lower end of a sound 
for special effects such as simulating a telephone 
effect.

Low-Shelf EQ Produces a lift or a cut below the 
specified frequency. 

Peak EQ Boosts or cuts only those frequencies 
centered around the selected center frequency. 
The Q button sets the bandwidth of the Peak fil-
ter. This determines the width of the filter’s 
overall slope — from a broad bell shape to a nar-
row notch. Broad curves tend to be most useful 
for musical applications. Narrow curves are use-
ful for special purpose processing such as hum 
removal. Higher values represent narrower 
bandwidths. Lower numbers represent wider 
bandwidths.

High-Shelf EQ Produces a lift or a cut at and 
above the specified frequency. 

Low Pass filter Attenuates all frequencies above 
the selected cutoff frequency setting at a rate of 
12 dB per octave while allowing all others below 
to pass through. For this reason, no gain control 
is available for this filter.



Dynamics II
There are five types of DigiRack dynamics pro-
cessors: Compressor, Limiter, Gate, Ex-
pander/Gate and De-esser.

Compressor II

The Compressor reduces the dynamic range of 
signals that exceed a selected threshold by a spe-
cific amount. The increase of input signal 
needed to cause a 1dB increase in the output sig-
nal of the compressor is called the compression 
ratio. With a ratio of 4:1, for example, an 8dB in-
crease of input produces a 2dB increase in the 
output. 

Audio material often varies in loudness, and can 
be above the threshold at one moment and be-
low it the next. The Attack slider sets the com-
pressor’s response time, or attack. The Release 
slider sets the amount of time that it takes for 
the compressor’s gain to return to its original 
level.

Compressor II plug-in
Using Compression Effectively

To use compression most effectively, the attack 
time should be set so that signals exceed the 
threshold level long enough to cause an increase 
in the average level. This helps ensure that gain 
reduction doesn’t decrease the overall volume. 

Release times should be set long enough that if 
signal levels repeatedly rise above the threshold, 
they cause gain reduction only once. If the re-
lease time is too long, a loud section of the audio 
material could cause gain reduction that persists 
through a soft section. Of course, compression 
has many creative uses that break these rules.

The Compressor has built-in metering that al-
lows you to monitor the amount of gain reduc-
tion taking place. The gain reduction meter usu-
ally remains at 0 level when the input signal is 
below the threshold and falls to the left to show 
the amount of gain reduction in decibels when 
the input signal exceeds the threshold. 

Compressor Parameters:

Phase Invert Inverts the phase (polarity) of the 
input signal, allowing you to change frequency 
response characteristics between multi-miked 
sources or to correct for miswired microphone 
cables.

Gain Provides overall output gain adjustment. It 
allows you to compensate for heavily com-
pressed signals. 

Compressor settings created in version 5.x 
and later of Pro Tools are not compatible 
with earlier versions. Saving a session in a 
pre- 5.x format will cause Compressor set-
tings to be lost.

 Phase Invert
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Input Meter Indicates the level of the unproc-
essed input signal to the Compressor.

Output Meter Indicates the output level of the 
Compressor, including any gain compensation 
added via the Gain parameter.

Reduction Indicates the amount of gain reduc-
tion in dB.

Threshold Sets the threshold level. Signals that 
exceed this level will be compressed. Signals 
that are below it will be unaffected. A level set-
ting of 0dB is equivalent to no compression. Un-
like scales on analog compressors, metering 
scales on a digital device reflect a 0dB value 
which indicates full scale (fs)—the full-code sig-
nal level. There is no headroom above 0db.

Ratio Sets the compression ratio. The range is 
based on decibels above the threshold. If this is 
set to 2:1 for example, it will compress changes 
in signals above the threshold by one half. 

Attack Sets the Compressor’s attack time. The 
smaller the value, the faster the attack. The 
faster the attack, the more rapidly the Compres-
sor applies attenuation to the signal. If you use 
fast attack times and heavy limiting, you should 
generally use a proportionally longer release 
time, particularly with material that contains 
many peaks in close proximity.

Release Controls how long it takes for the Com-
pressor to be fully deactivated after the input 
signal drops below the threshold level. In gen-
eral, if you use heavy compression, you should 
use proportionally longer release times in order 
to avoid pumping which may occur when the 
Compressor is forced to jump back and forth be-
tween compressed and uncompressed signal 
levels. Lengthening the release time will help 
smooth these changes in level by introducing a 
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lag in the ramp-up/down time of attenuation. 
Use shorter release times on material with fewer 
peaks which do not occur in close proximity to 
each other.

Knee Sets the rate at which the compressor 
reaches full compression once the threshold has 
been exceeded. This parameter ranges from 0 
(hardest response) to 200 (softest response). 

Graph Displays the response curve set by the 
Compressor’s Threshold, Ratio, and Knee set-
tings. As you adjust these parameters, refer to 
the graph to see how the shape of this curve 
changes. This will allow you to see the effect of 
your settings.

External Key Enables and disables side chain 
processing. Side chain processing allows the 
Compressor to listen to the varying amplitude 
of a separate reference track and use it to trigger 
compression. See “Using a Key Input for Side 
Chain Processing” on page 34.

Key Listen When enabled, this allows you to lis-
ten to the reference track controlling the side 
chain input. This is often useful for fine tuning 
the Compressor’s settings to the key input. Key 
Listen auditions the right audio channel on 
TDM and RTAS versions of the Compressor.



Limiter II

The Limiter is used to prevent signal peaks from 
ever exceeding a chosen level so that they don’t 
overload amplifiers or recording devices. Most 
limiters have ratios of 10:1 or 20:1, although 
some provide ratios of up to 100:1. Large ratios 
effectively limit the dynamic range of the signal 
to a specific value by setting an absolute ceiling 
for the dynamic range.

Limiting is used to prevent short-term peaks 
from reaching their full amplitude. Used judi-
ciously, limiting allows you to achieve higher 
average levels, while avoiding overload (clip-
ping or distortion), by limiting only some short-
term transients in the source audio. To prevent 
the ear from hearing the gain changes, ex-
tremely short attack and release times are used. 

Limiting is used to remove only occasional 
peaks because gain reduction on successive 
peaks wouldn’t be noticeable. If audio material 
contains many peaks, the threshold should be 
raised and the gain manually reduced so that 
only occasional, extreme peaks are limited.

Limiter II plug-in
The Limiter’s ratio is internally set to 100:1, and 
the Attack time is automatically set to 0 millisec-
onds. The Limiter is similar to heavy compres-
sion. It can be useful for reducing pops and 
clicks, or for hard-limiting dynamic range for 
broadcast or band-limited mediums such as cas-
sette.

Limiter Parameters

Phase Invert Inverts the phase (polarity) of the 
input signal, allowing you to change frequency 
response characteristics between multi-miked 
sources or to correct for miswired microphone 
cables.

Gain Provides overall output gain adjustment. 

Input Meter Indicates the level of the unproc-
essed input signal to the Limiter.

Output Meter Indicates the output level of the 
Limiter, including any gain compensation 
added via the Gain parameter.

Reduction Indicates the amount by which the 
signal is being attenuated.

Threshold Sets the threshold level. Signals that 
exceed this level will be limited. Signals that are 
below it will be unaffected. 

Attack Sets the Limiter’s attack time. The 
smaller the value, the faster the attack. The 
faster the attack, the more rapidly the Limiter 
applies attenuation to the signal. If you use fast 
attack times and heavy limiting, you should 
generally use a proportionally longer release 
time, particularly with material that contains 
many peaks in close proximity.
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Release Controls how long it takes for the Lim-
iter to be fully deactivated after the input signal 
drops below the threshold level. In general, if 
you use heavy limiting, you should use propor-
tionally longer release times in order to avoid 
pumping which may occur when the Limiter is 
forced to jump back and forth between limited 
and unlimited signal levels. Lengthening the re-
lease time will help smooth these changes in 
level by introducing a lag in the ramp-up/down 
time of attenuation. Use shorter release times on 
material with fewer peaks which do not occur in 
close proximity to each other.

Graph Displays the response curve set by the 
Limiter’s Threshold setting. As you adjust these 
parameters, refer to the graph to see how the 
shape of this curve changes. This will allow you 
to see the effect of your settings.

External Key Enables and disables side chain 
processing. Side chain processing allows the 
Limiter to listen to the varying amplitude of a 
separate reference track and use it to trigger lim-
iting. See “Using a Key Input for Side Chain Pro-
cessing” on page 34.

Key Listen When enabled, this allows you to lis-
ten to the reference track controlling the side 
chain input. This is often useful for fine tuning 
the Limiter’s settings to the key input. Key Lis-
ten auditions the right audio channel on TDM 
and RTAS versions of the Limiter.
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Gate II

The Gate (also known as a noise gate) allows a 
signal above the selected threshold to be passed 
through to the output at unity gain, without dy-
namic processing. Once the input signal falls be-
low the threshold level, the gating shuts down 
the signal by fully or partially attenuating the 
output. In this way, the desired signal is allowed 
to pass, but unwanted signal is not. The Gate is 
useful for noise removal on individual tracks, 
and can be used for special effects such as cut-
ting off a reverb tail.

Gate Parameters

Phase Invert Inverts the phase (polarity) of the 
input signal, allowing you to change frequency 
response characteristics between multi-miked 
sources or to correct for miswired microphone 
cables.

Gating Indicates the amount of reduction in dB.

Threshold Sets the threshold level. Signals that 
exceed this level will pass through. Signals that 
are below it will be gated, depending on the set-
tings of the Attack, Hold, Decay, and Range pa-
rameters (explained below). 

Gate II plug-in



Attack Sets the attack time of the Gate.

Hold Specifies a duration (in seconds or millisec-
onds) that the Gate will stay open after the ini-
tial attack cycle. This can be used as a one-shot 
function to keep the Gate open for longer peri-
ods of time with a single crossing of the thresh-
old. It can also be used to prevent gate chatter 
which may occur if varying input levels near the 
threshold cause the Gate to open and close very 
rapidly.

Decay Controls how long it takes for the Gate to 
close after the signal falls below the threshold 
level.

Range Sets the depth of the Gate when closed. It 
has a maximum depth of -80db. Setting the gate 
to higher range levels allows more of the gated 
audio that falls below the threshold to peek 
through the gate at all times. This is useful for 
things such as drum leakage, where you may 
want to suppress the overall drum kit sound by 
a specific amount, while emphasizing the gated 
instrument such as a snare.

Graph Displays the response curve set by the 
Gate’s Threshold and Range settings. As you ad-
just these parameters, refer to the graph to see 
how the shape of this curve changes. This will 
allow you to see the effect of your settings.

External Key Enables and disables side chain 
processing. Side chain processing allows the 
Gate to listen to the varying amplitude of a sep-
arate reference track and use it to trigger limit-
ing. See “Using a Key Input for Side Chain Pro-
cessing” on page 34.

Key Listen When enabled, this allows you to lis-
ten to the reference track controlling the side 
chain input. This is often useful for fine tuning 
the Gate’s settings to the key input.
Expander/Gate II

The Expander/Gate reduces noise by decreasing 
the gain of signals that fall below a user-select-
able threshold. Expanders are particularly useful 
for reducing noise or signal leakage that creeps 
into recorded material as its level falls, as often 
occurs in the case of headphone leakage.

Expanders can be thought of as soft noise gates 
since they provide a gentler way of cutting off 
noisy low-level signals than the typically abrupt 
cutoff of a gate. If you want, however, you can 
actually use this plug-in as a gate, simply by set-
ting the Ratio to its maximum value and using 
short attack, decay, and release settings.

Expander/Gate Parameters

Phase Invert Inverts the phase (polarity) of the 
input signal, allowing you to change frequency 
response characteristics between multi-miked 
sources or to correct for miswired microphone 
cables.

Reduction Meter Indicates the amount of signal 
reduction in dB.

Expander/Gate II plug-in
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Threshold Sets the threshold level. Signals that 
fall below the threshold will be reduced in gain. 
Signals that are above it will be unaffected. 
(When adjusting the Threshold slider be sure 
that audio material is playing through the Ex-
pander/ Gate to see changes reflected in the Re-
duction meter.)

Ratio Sets the amount of expansion. If this is set 
to 2:1 for example, it will lower signals below 
the threshold by one half. At higher ratio levels 
(30:1 or 40:1 for example) the Expander/Gate 
functions like a gate by reducing lower level sig-
nals much more dramatically. As you adjust the 
ratio parameter, refer to the built-in graph to see 
how the shape of the expansion curve changes.

Attack Sets the Expander’s attack time. This de-
termines how quickly a signal’s level is reduced 
once it falls below the threshold. This, along 
with the ratio setting, allows you to control how 
soft the Expander’s gain reduction curve is.

Hold Specifies a duration (in seconds or millisec-
onds) that the Expander/Gate will stay open af-
ter the initial attack cycle. This can be used as a 
one-shot function to keep the Expander/Gate 
open for longer periods of time with a single 
crossing of the threshold. It can also be used to 
prevent gate chatter which may occur if varying 
input levels near the threshold cause the gate to 
open and close very rapidly.

Decay Controls how long it takes for the gate to 
close after the input signal falls below the 
threshold level and the hold time has passed.

Range Sets the depth of the gate when closed. It 
has a maximum depth of -80db. Setting the gate 
to higher range levels allows more and more of 
the gated audio that falls below the threshold to 
peek through the gate at all times.
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Key HPF This is a high-pass filter that removes 
low frequencies in the Key Input signal. This al-
lows you to define a specific frequency range of 
the Key Input to trigger the Expander/Gate. A 
typical use for this feature is to filter a drum 
track used as a Key Input so that only specific 
high frequencies (such as a snare drum) will 
open the Gate.

Key LPF This is a low-pass filter that removes 
high frequencies in the Key Input signal. This al-
lows you to define a specific frequency range of 
the Key Input to trigger the Expander/Gate. A 
typical use for this feature is to filter a drum 
track used as a Key Input so that only specific 
low-frequencies (such as a kick drum or tom) 
trigger the Expander/Gate.

Graph Displays the response curve set by the Ex-
pander/Gate’s Threshold, Ratio, and Range set-
tings. As you adjust these parameters, refer to 
the graph to see how the shape of this curve 
changes. This will allow you to see the effect of 
your settings.

External Key Enables and disables side chain 
processing. Side chain processing allows the Ex-
pander/Gate to listen to the varying amplitude 
of a separate reference track and use it to trigger 
expansion. 

Key Listen When enabled, this allows you to lis-
ten to the reference track controlling the side 
chain input. This is often useful for fine tuning 
the Expander/Gate’s settings to the key input.

Expander/Gate settings created in version 
5.x and later of Pro Tools are not compati-
ble with earlier versions. Saving a session in 
a pre- 5.x format will cause settings to be 
lost.



De-esser

The De-esser reduces sibilants (“s,” “sh,” and “t” 
sounds) and other high frequency noises that 
can occur in vocals, voice-overs, and wind in-
struments such as flutes. These sounds can cause 
peaks in an audio signal and lead to distortion. 

The De-esser reduces these unwanted sounds us-
ing fast-acting compression. A Threshold con-
trol sets the level above which compression 
starts, and a Frequency control sets the fre-
quency band in which the De-esser operates. 

Using De-essing Effectively

To use de-essing most effectively, the De-esser 
should be used before any compressor or limiter 
plug-ins. 

Because too much de-essing can make audio ma-
terial sound lifeless, it is best used on individual 
tracks rather than entire mixes.

The Frequency slider should be set to remove 
sibilants (typically the 4–10 kHz range) and not 
other parts of the signal. This helps prevent de-
essing from changing the original character of 
the audio material. 

De-esser plug-in

The De-esser is a monophonic-only plug-in.
Similarly, Threshold should be set high enough 
that de-essing is triggered only by sibilants. If 
the Threshold is set too low, a loud, non-sibilant 
section of audio material could cause unwanted 
gain reduction or cause sibilants to be over at-
tenuated.

To improve de-essing of material that has both 
very loud and very soft passages, automate the 
Threshold control so that it is lower on soft sec-
tions.

De-esser Parameters:

Input Meter Indicates the level of the unproc-
essed input signal to the De-esser.

Output Meter Indicates the output level of the 
De-esser.

Reduction Indicates the amount of gain reduc-
tion in dB. It remains at 0 dB level when the in-
put signal is below the threshold.

Threshold Sets the threshold level. Signals that 
exceed this level will be compressed. Signals 
that are below it will be unaffected. A setting of 
0 dB is equivalent to no de-essing.

Frequency Sets the frequency band in which the 
De-esser operates. Frequencies in the specified 
range will be gain reduced. To find the optimum 
Frequency setting, sweep this control back and 
forth during audio playback.

Key Listen Monitors the sibilant peaks used by 
the De-esser as a key input to trigger compres-
sion. This is useful for listening only to the sibi-
lance and fine tuning settings to remove them.
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Using a Key Input for Side Chain 
Processing

You can use the side-chain processing capabili-
ties of the Compressor, Limiter, Gate, or Ex-
pander/Gate to trigger any of these plug-ins 
from a separate reference track or external audio 
source.

By using the External Key input, you can control 
the dynamics of one audio signal using the dy-
namics of another signal (the key input). A typ-
ical use for this feature is to use one instrument 
to trigger gating of another: a kick drum to gate 
and tighten up a bass track, a rhythm guitar to 
gate a keyboard pad, and many other creative 
applications. 

To use a key input for side chain processing:

1  Click the Insert pop-up on the desired track to 
select the desired plug-in.

2  Click the Side Chain Input pop-up and select 
the input/bus that carries the audio you want to 
use to trigger the plug-in.

3  Click the Key Input button. This activates side 
chain processing.

4  If you want to hear the audio source you have 
selected to control side chain input, click the 
Key Listen button.

5  If you want to filter the Key Input so that only 
certain frequencies trigger the plug-in, use the 
Key HPF and Key LPF controls to select the de-
sired frequency range.

6  Begin playback. The plug-in is now using the 
input/bus that you chose as a side chain input to 
trigger its effect.

Side-chain inputs are monophonic only.
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7  Adjust the plug-in’s Threshold parameter to 
fine tune the side chain triggering.

8  Adjust other parameters of the plug-in to 
achieve final effect that you want.

Mod Delay
The Mod Delay plug-in provides time delay-
based effects. Effects obtained through the use 
of Mod Delay include slap echo, doubling, cho-
rusing, and flanging. 

There are four different Mod Delays, each of 
which is capable of a different maximum delay 
time:

• The Short Delay provides 1024 samples of de-
lay (23.2 milliseconds at 44.1 kHz or 21.3 ms 
at 48 kHz).

• The Slap Delay provides 7186 samples of de-
lay (162 ms at 44.1 kHz or 149 ms at 48 kHz).

• The Medium Delay provides 16384 samples of 
delay (371 ms at 44.1 kHz kHz or 341 ms at 
48 kHz).

Mod Delay plug-in



• The Long Delay provides 162474 samples of 
delay (3.68 seconds at 44.1 kHz or 3.38 sec-
onds at 48 kHz).

The Mod Delay plug-ins can be cascaded on in-
serts one into another to achieve even longer 
delay times. If you do this, set the feedback of 
intermediate delays to zero to get predictable re-
sults. Use the feedback control of the last delay 
in the chain to set the number of repeats. 

The Mod Delays are unique among the DigiRack 
TDM plug-ins in that they each provide a Mono 
In/Stereo Out option. Choosing a delay in the 
Mono In/Stereo Out format allows you to “stere-
oize” the output of a mono track. A track created 
in this way will then have stereo pan faders for 
controlling each channel of the stereo signal. As 
explained previously, any inserts that occur on a 
track after a stereo Insert will automatically be-
come stereo as well.

Mod Delay Parameters

Input Controls the input volume of the delay, al-
lowing you to prevent clipping.

Wet/Dry Controls the balance between the de-
layed signal and the original signal. If you are 
using a delay for flanging or chorusing, you can 
control the depth of the effect somewhat with 
the Wet/Dry setting.

LPF (Low Pass filter) Controls the cutoff fre-
quency of the low-pass filter. This allows you to 
attenuate the high frequency content of the 
feedback signal. The lower the setting, the more 
high frequencies are attenuated.

Delay Sets the delay time between the original 
signal and the delayed signal.

The Long Delay TDM plug-in is only avail-
able on systems equipped with a 
Pro Tools 24 MIX card.
Depth Controls the depth of the modulation ap-
plied to the delayed signal. 

Rate Controls the rate of modulation of the de-
layed signal.

Feedback Controls the amount of feedback ap-
plied from the output of the delay back into its 
input. It also controls the number of repetitions 
of the delayed signal. Negative feedback settings 
give a more intense “tunnel-like” sound to 
flanging effects.

Trim
(TDM Systems Only)

The Trim plug-in can be used to add up to +6 dB 
of additional gain to an audio signal. Using a 
multi-mono Trim plug-in on a multi-channel 
track provides simple, DSP-efficient muting con-
trol over the individual channels of the track. 
This capability is useful, since Track Mute but-
tons mute all channels of a multi-channel track 
and do not allow muting of individual channels 
within the track.

Trim plug-in
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Trim Parameters

Phase Invert Inverts the phase (polarity) of the 
input signal, allowing you to change frequency 
response characteristics between multi-miked 
sources or to correct for miswired microphone 
cables.

Gain Provides up to +6 dB of additional gain ad-
justment. 

Output Meter Indicates the output level, includ-
ing any gain compensation added using the 
Gain parameter.

Procrastinator Extended 
Delay
(Pro Tools 24 Only)

The Procrastinator™ plug-in provides a long de-
lay effect for TDM-based systems without a 
Pro Tools 24 MIX card, since systems without 
this card do not support the Long Mod Delay 
plug-in. 

Procrastinator plug-in 
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Because it consumes considerably more process-
ing power that the standard Mod Delay plug-
ins, Procrastinator requires one entire DSP on a 
DSP Farm card per usage and is only available in 
mono mode. It can be used in either 16-bit res-
olution or 24-bit resolution.

To obtain Procrastinator’s full two seconds of 
delay, use it in 16-bit mode. For higher band-
width processing, and shorter maximum delay 
time, use it in 24-bit mode. (If you choose 16-
bit, the signal on that channel will be processed 
at 16-bit resolution rather than the TDM mixing 
environment’s standard 24-bit resolution.

Procrastinator Parameters

Input Level Controls the input volume of Pro-
crastinator, allowing you to prevent clipping. 
Pro Tools inserts are pre-fader and Plug-ins as-
signed to inserts can cause clipping if their levels 
are set too high. 

It may sometimes be necessary to prevent clip-
ping when using feedback. The LEDs next to the 
slider are for input monitoring; the green LED 
indicates signal present (-60dB) and the red in-
dicates clipping. To reset it, click it.

Mix Controls the balance between the delayed 
signal and the original signal. The dry signal is 
implemented as passthrough with no added de-
lay. The wet signal includes the delayed signal 
with any specified feedback.

Delay Sets the delay time between the original 
signal and the delayed signal. Use it in conjunc-
tion with the feedback control to generate a sin-
gle echo or a series of echoes. Moving this slider 
during playback may cause undesirable audio 
artifacts.

Procrastinator can only be used on systems 
with a DSP Farm card.



Feedback (FB) Controls the amount of feedback 
(positive or negative) applied from the output of 
the delay back into its input. This allows you to 
control the number of repetitions of the delayed 
signal. 

The pre/post switch selects whether the feed-
back signal is taken pre-mix (wet only) or post-
mix (actual output). Post-mix feedback is af-
fected by the Mix control setting. To see a signal 
path diagram illustrating the effect of the 
pre/post switches, click on the Procrastinator 
logo; it will display the current signal flow. Click 
again to return to the logo.

Low Pass Filter (LPF) Controls the cutoff fre-
quency of the low-pass filter. This allows you to 
attenuate the high frequency content of the 
feedback signal. The lower the setting, the more 
high frequencies are attenuated. Moving the 
slider all the way to the right sets it to the off po-
sition. The pre/post switch determines whether 
the LPF is pre-feedback (affects the initial de-
layed repeat) or post-feedback (affects only the 
second and successive repeats).

Tempo-Related Controls

The remaining parameters of the Procrastinator 
plug-in provide you with an alternate method 
for entering a desired delay value. Rather than 
selecting a delay time, it allows you to set a 
tempo and the desired number of beats of delay.

Tempo Selects the desired tempo in beats per 
minute (bpm). This setting is independent of 
Pro Tools’ tempo. When a specific Duration is 
selected (see “Duration” below) moving this 
control will affect the Delay setting and vice-
versa. Likewise, the range of both controls will 
be limited to the maximum available delay with 
the currently selected Duration. To enter very 
slow tempos or short delays it may be necessary 
to deselect all Duration buttons.
Duration Specifies a desired delay from a musical 
perspective. Using the guideline of one beat is 
equal to one quarter note, enter the desired de-
lay by selecting appropriate durations. You can 
enable multiple buttons by Shift-clicking them.

Groove Provides fine adjustment of the delay in 
percentages of a sixteenth note. It can be used to 
add a groove by slightly offsetting the delay 
from the precise beat of the track.

Dither
The Dither plug-in is designed for improved 
16-, 18-, or 20-bit performance and reduced 
quantization noise when mixing or fading low-
level audio signals.

Dither is a form of randomized noise used to 
minimize quantization errors in digital audio 
systems. Quantization distortion is most audible 
when the audio signal is near the low end of its 
dynamic range, such as during a quiet passage or 
fade-out. 

The introduction of dithering can reduce these 
quantizing errors with very low-level random 
noise, minimizing distortion products as audio 
reaches low level. With dithering there is a 
trade-off between signal-to-noise performance 
and less-apparent distortion. Proper use of dith-
ering allows you to squeeze better subjective 
performance out of 16-bits (or whatever your 
destination bit-depth is).

 Dither plug-in
Chapter 4: DigiRack Real-Time TDM and RTAS Plug-Ins 37



38
The most common application of dithering is to 
use it on a master output mix as the last proces-
sor in the signal path when preparing a 24-bit 
session for CD mastering. In this case, you 
would place the Dither plug-in on a Master 
Fader as a post-fader Insert to reduce session bit-
depth from 24-bits to 16-bits. 

The Dither plug-in has user-selectable bit resolu-
tion and a noise shaping on/off option.

Noise Shaping

The Dither plug-in features a technique known 
as noise shaping to further improve audio per-
formance and reduce perceived noise in low-
level signals. Noise shaping utilizes digital filter-
ing to remove noise that falls in the middle of 
the audio spectrum (specifically, around 4 kHz). 
This is the range where human hearing is most 
sensitive. 

In reality, since the noise plays an important 
role in reducing quantization errors (and 
thereby audio artifacts) the noise is not reduced 
in total, but is shifted into a range where it is 
harder to hear. Essentially, noise shaping lessens 
our perception of the noise inherent in dither-
ing schemes by shifting audible noise compo-
nents into a less audible range.

If you are outputting audio to an analog 
destination with a 24-bit-capable Pro Tools 
system and an 888/24 I/O, do not use 
dither. This allows maximum output fidel-
ity from the 888/24 I/O’s high-performance 
24-bit digital-to-analog convertors.
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Dither and Output Bit Resolution

Dither has two user-selectable parameters that 
allow you to optimize its operation:

Bit Resolution

This pop-up menu allows you to choose one of 
three possible resolutions for the Dither process-
ing. As a general rule, you should set this param-
eter to the maximum bit resolution of your des-
tination.

16-bit Recommended for output to digital de-
vices such as DAT recorders and CD recorders, 
since they have a maximum resolution of 16-
bits.

18-bit Recommended for output to analog de-
vices if you are using an 888 I/O or 882 I/O Au-
dio Interface since this is the maximum resolu-
tion available from the 18-bit digital-to-analog 
convertors of these devices.

20-bit Recommended for output to digital de-
vices that support a full 20-bit recording data 
path, such the Sony PCM-9000 optical master-
ing recorder, or the Alesis ADAT XT 20. This set-
ting is also recommended for output to analog 
devices if you are using an 882/20 I/O Audio In-
terface. The 20-bit setting can also be used with 
digital effects devices that support 20-bit input 
and output, since it provides for a lower noise 
floor and greater dynamic range when mixing 
20-bit signals directly into the TDM environ-
ment.

If you want, you can choose not to use the 
Dither plug-in and instead utilize the full 24-bit 
resolution of Pro Tools’ digital output, depend-
ing on your destination device. As noted previ-
ously, if you have a 24-bit-capable Pro Tools sys-
tem with an 888/24 I/O Audio Interface and are 
outputting audio to an analog destination, we 
recommend that you do not use dither.



Noise Shape

This button engages or disengages Noise Shap-
ing. When lit, noise shaping is on. See the previ-
ous section regarding Noise Shaping for more 
information. 

TimeAdjuster
(TDM Systems Only)

The TimeAdjuster plug-in provides three func-
tions: 

• Compensation for delays due to TDM-based 
routing

• Gain compensation (+/– 24 dB)

• Phase inversion for correcting out-of-phase 
signals

The TimeAdjuster plug-in is the most efficient 
way to compensate for DSP processing delays in 
your Pro Tools system.

See the Pro Tools Reference Guide for details 
on using the Dither plug-in during mix-
down.

TimeAdjuster plug-in
TimeAdjuster Parameters

Phase Invert Inverts the phase (polarity) of the 
input signal. While most Digidesign plug-ins 
supply a phase invert button of their own, some 
third-party plug-ins may not. In addition, phase 
inversion is useful for performing delay com-
pensation by tuning unknown delay factors by 
ear (see the section that follows).

Gain Provides up to 24dB of positive or negative 
gain adjustment. This control is useful for alter-
ing the gain of a signal by a large amount in real 
time. For example, when you are working with 
audio signals that are extremely low level, you 
may want to adjust the channel gain to a rea-
sonable working range so that a fader is posi-
tioned at its optimum travel position. This con-
trol allows you to make a wide range of gain 
adjustment in real time without having to per-
manently process the audio files, as you would 
with an AudioSuite plug-in.

Delay Provides up to 2048 samples of delay com-
pensation adjustment, or for general adjust-
ment of phase relationships of audio recorded 
with multiple microphones. It defaults to a min-
imum delay of four samples, which is the delay 
created by use of the TimeAdjuster plug-in itself. 
(This is the minimum delay that an individual 
plug-in will create.) 

While phase inversion controls have been used 
for many years by engineers as creative tools for 
adjustment of frequency response between mul-
tiple microphones, sample-level delay adjust-
ments provide far more finite control. Creative 
use of this control can provide a powerful tool 
for adjusting frequency response and timing re-
lationships between audio signals recorded with 
multiple microphones.
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Using TimeAdjuster for Delay 
Compensation

DSP processing in all digital systems incurs de-
lay of varying amounts. You can use the Time-
Adjuster TDM plug-in to apply an exact number 
of samples of delay to the signal path of a 
Pro Tools track to compensate for delay incurred 
by specific plug-ins. TimeAdjuster provides pre-
sets for common delay-compensation scenarios.

To compensate for several plug-ins in-line, use 
the delay times from each settings file as refer-
ences, and add them together to derive the total 
delay time.

Alternatively, look up the delay in samples for 
the plug-ins you want to compensate for, then 
apply the appropriate amount of delay.

To compensate for DSP-induced delays, try one 
of the following methods:

Phase Inversion

If you are working with phase-coherent track 
pairs, or tracks recorded with multiple micro-
phones, you can use a common studio tech-
nique to null out the delay. Flop the phase of 
the target track using the TimeAdjuster plug-in’s 
Phase Invert button, and adjust the plug-in’s de-
lay time until the signal disappears. Then disen-
gage the Phase Invert button.

If you don’t hear any audio when you flop a sig-
nal’s phase, you have precisely adjusted and 
compensated for the delay. This is because when 
you monitor duplicate signals and invert the po-

A delay table for DigiRack plug-ins appears 
in Appendix B, “DSP Delays Incurred by 
TDM Plug-Ins.”
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larity (phase) of one of them, the signals will be 
of opposite polarity and cancel each other out. 
This method is convenient for finding the exact 
delay setting for any plug-in. 

To determine the delay of a plug-in by inverting its 
signal phase:

1  Place duplicate audio regions on two different 
audio tracks and pan them to the center 
(mono). 

2  Apply the plug-in whose delay you want to 
calculate to the first track, and a Time Adjuster 
plug-in to the second track. 

3  With TimeAdjuster, reverse the phase. 

4  Command-drag (Macintosh) or Control-drag 
(Windows) to fine-tune delay in one sample in-
crements, or use the up/down arrow keys to 
change the delay one sample at a time until the 
audio signal disappears.

5  Flop the polarity back to normal. 

6  Save the TimeAdjuster setting for later use.

Comb-Filter Effect Cancellation

Adjust the delay with the signal in phase until 
any comb-filter effects cancel out.

Viewing Channel Delay

Because TDM plug-ins display their delay values 
in the Mix window’s channel delay indicators, 
there is a third method for determining delay 
compensation, performed as follows.



To view time delay values and use TimeAdjuster to 
compensate for the delay:

1  In the Mix window, Command-click (Macin-
tosh) or Control-click (Windows) the Track 
Level Indicator to toggle between level (which 
appears on the display as “vol”), headroom 
(“pk”), and channel delay (“dly”) indications. 
Delay values are shown in samples. 

2  Apply the TimeAdjuster plug-in to the track 
whose delay you want to increase, and Com-
mand-click (Macintosh) or Control-click (Win-
dows) its Track Level indicator until the channel 
delay value is displayed for that track.

3  Change the delay time in TimeAdjuster by 
moving the Delay slider or entering a value in 
the Delay field, until the channel delay value 
matches that of the first track.

4  Test the delay values by duplicating an audio 
track and reversing its phase while compensat-
ing for delay.

When to Compensate for Delays

If you want to compensate for delays across your 
entire system, you will want to calculate the 
maximum delay incurred on any channel, and 
apply the delays necessary to each channel to 
match this channel.

Determining the DSP delay of track inserts
However, this may not always be necessary. You 
may only really need to compensate for delays 
between tracks where phase coherency must be 
maintained (as with instruments recorded with 
multiple microphones or stereo pairs). If you are 
working with mono signals, and the accumu-
lated delays are small (just a few samples, for ex-
ample), you probably needn’t worry about delay 
compensation.

Signal Generator
The Signal Generator plug-in produces audio 
test tones in a variety of frequencies, waveforms, 
and amplitudes. It is useful for generating refer-
ence signals with which to calibrate the 
888/24 I/O and other elements of your studio. 
See the Pro Tools TDM Hardware Installation 
Guide for instructions on using Signal Generator 
to calibrate the 888/24 I/O Audio Interface.

For more information about delays and 
mixing in TDM systems, see the Pro Tools 
Reference Guide.

Signal Generator plug-in

The signal generator produces a tone as 
soon as it is inserted on a track. To mute the 
Signal Generator, use the Bypass button.
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Signal Generator Parameters

Frequency Sets the frequency of the signal in 
hertz. Values range from a low of 20 Hz to a 
high of 20 kHz.

Level Sets the amplitude of the signal in deci-
bels. Values range from a low of -95 dB to a high 
of 0.0 dB.

Signal These buttons select the waveform. 
Choices are sine, square, sawtooth, triangle, 
white noise, and pink noise.
DigiRack Plug-Ins Guide



chapter 5

DigiRack Non-Real-Time AudioSuite Plug-Ins
EQ II
The EQ II plug-in allows you to use either a 1-
band or 4-band EQ to adjust the frequency spec-
trum of an audio selection. The 1-band EQ can 
be configured as a hi-pass, lo-shelf, hi-shelf, lo-
pass or peak EQ. The 4-band EQ provides one hi-
shelf, one lo-shelf and two peak EQs.

The features of these plug-ins are identical to 
their real-time TDM counterparts. The only dif-
ference is that the AudioSuite versions operate 
in non-real time, while the TDM versions oper-
ate in real time. 

1-band EQ II AudioSuite plug-in
4-band EQ II AudioSuite plug-in

For information on the individual parame-
ters of these plug-ins, see “EQ II” on 
page 25.
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Dynamics II
Four different AudioSuite dynamics plug-ins are 
provided with Pro Tools: 

• Compressor II

• Limiter II

• Gate II

• Expander/Gate II

• De-esser

The features of these plug-ins are identical to 
their real-time counterparts. The only difference 
is that the AudioSuite versions operate in non-
real time.

For information on the individual parame-
ters of these plug-ins, see “Dynamics II” on 
page 27.

Compressor II AudioSuite plug-in
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Limiter II AudioSuite plug-in

Gate II AudioSuite plug-in



Expander/Gate II AudioSuite plug-in

De-esser plug-in
Invert
The Invert plug-in reverses the polarity of the se-
lected audio. All positive sample amplitude val-
ues are made negative, and all negative ampli-
tudes are made positive. This process is useful 
for permanently altering the phase (polarity) re-
lationship of tracks. The Invert plug-in is partic-
ularly useful during mixing because it allows 
you to modify frequency response between 
source tracks recorded with multiple micro-
phones. It also allows you to correct for audio re-
corded out of phase with an incorrectly wired 
cable.

Duplicate
The Duplicate plug-in duplicates the selected 
audio in place. Depending on how its parame-
ters are configured, the new region will appear 
in either the Regions List or playlist. This allows 
you to “flatten” or consolidate an entire track 
consisting of multiple regions into one continu-
ous audio file that resides in the same place as 
the original individual regions. 

The audio is unaffected by Pro Tools volume or 
pan automation, or by any real-time plug-ins 
that may be in use on the track as inserts. The 
original audio file regions are merely rewritten 
in place to a single duplicate file.

Invert plug-in

Duplicate plug-in
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The Duplicate plug-in always works in non-de-
structive mode—you cannot choose to over-
write files. The original source files will always 
be retained. 

Mod Delay
The Mod Delay plug-in provides time delay-
based effects. Effects you can create with these 
plug-ins include slap echo, doubling, chorusing, 
and flanging. 

The features of these plug-ins are identical to 
their real-time counterparts. The only difference 
is that the AudioSuite versions operate in non-
real time. 

There are four different Mod Delays, each of 
which is capable of a different maximum delay 
time:

• The Short Delay provides 1024 samples of de-
lay (23.2 milliseconds at 44.1 kHz or 21.3 ms 
at 48 kHz).

• The Slap Delay provides 7186 samples of de-
lay (162 ms at 44.1 kHz or 149 ms at 48 kHz).

• The Medium Delay provides 16384 samples of 
delay (371 ms at 44.1 kHz kHz or 341 ms at 
48 kHz).

• The Long Delay provides 162474 samples of 
delay (3.68 seconds at 44.1 kHz or 3.38 sec-
onds at 48 kHz).

For information on the individual parame-
ters of these plug-ins, see “Mod Delay” on 
page 34.
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Normalize
The Normalize plug-in allows you to optimizing 
a selected region’s playback level. It is useful in 
cases where an audio file has been recorded with 
too little amplitude, or where volume is incon-
sistent throughout the duration of an audio file 
(as in a poorly recorded narration). Applying 
Normalization to a selection raises its overall 
volume level while ensuring that the inherent 
dynamics of the material remain unchanged.

The Max Peak At Parameter

In addition to the standard AudioSuite func-
tions, the Normalize plug-in provides a Max 
Peak At parameter which lets you specify how 
close to maximum level (clipping threshold) the 
peak level of your selection will be boosted. 

You can specify this value by manually adjust-
ing the Max Peak At slider, or by entering a nu-
meric decibel value below the clipping thresh-
old, or by entering a percentage of the clipping 
threshold. 

The Normalize plug-in allows stereo pairs to be 
processed together so that the two sides of the 
stereo signal are processed relative to each other. 

When multiple regions are selected across mul-
tiple tracks, the Normalize plug-in can search 
for peaks in two different modes:

Normalize plug-in



Peak On Each Track Searches for the peak level 
on a track-by-track basis.

Peak From All Tracks Searches for the peak level 
of the entire selection. If ten tracks are selected, 
for example, the Normalize function will find 
the peak value from all ten.

Gain
The Gain plug-in allows you to boost or lower a 
selected region’s amplitude by a specific 
amount. It is ideal for smoothing out undesir-
able peaks and other dynamic inconsistencies in 
audio material. 

Gain Parameter

In addition to the standard AudioSuite func-
tions, the Gain plug-in provides a Gain parame-
ter which lets you specify the desired gain level. 

You can specify this value by manually adjust-
ing the Gain slider, or by entering a numeric 
decibel value, or by entering a percentage. 

Gain plug-in
Reverse
The Reverse plug-in allows you to modify a se-
lection so that it plays backwards. This effect has 
many useful applications in music, film, and 
video. 

Signal Generator
The Signal Generator plug-in produces audio 
test tones in a variety of frequencies, waveforms, 
and amplitudes. 

The features of this plug-in are identical to its 
real-time TDM counterpart. The only difference 
is that the AudioSuite version operates in non-
real time, while the TDM version operates in 
real time.

Reverse plug-in

Signal Generator plug-in
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DC Offset Removal
The DC Offset Removal plug-in removes DC off-
set from audio files. DC offset is a type of audio 
artifact that can appear in digital audio signals 
as a result of miscalibrated analog-to-digital 
convertors.

DC offset can be easily identified in a waveform. 
In portions of the audio file where there should 
be silence, the DC offset appears as a near-verti-
cal fade in with a constant or steady-state offset 
from zero.

If you find DC offset in an audio file, you should 
always use the DC Offset plug-in to remove it, 
since DC Offset can cause pops or clicks to occur 
on edited material. 

DC Offset Removal plug-in
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De-esser
The De-esser plug-in reduces sibilants (“s,” “sh,” 
and “t” sounds) and other high frequency 
noises that can occur in vocals, voice-overs, and 
wind instruments such as flutes. These sounds 
can cause peaks in an audio signal and lead to 
distortion. 

The De-esser reduces these unwanted sounds us-
ing fast-acting compression. A Threshold con-
trol sets the level above which compression 
starts, and a Frequency control sets the fre-
quency band in which the De-esser operates.

De-esser plug-in



Time Compression/ 
Expansion
The Time Compression/Expansion plug-in al-
lows you to adjust the duration of selected re-
gions, increasing or decreasing their length 
without changing pitch. 

This is a particularly useful function in audio 
post-production applications since it allows au-
dio to be adjusted to specific time lengths or 
SMPTE durations for synchronization purposes. 
Time Compression/Expansion always works in 
non-destructive mode.

Time Compression/Expansion plug-in

Normalizing a selection before using Time 
Compressing/Expansion will often produce 
better-sounding results.
Time Compression/Expansion 
Parameters

In addition to the standard AudioSuite func-
tions, the Time Compression/Expansion plug-in 
provides the following parameters: 

Source and Destination The Source fields display 
the length of the current selection before pro-
cessing in each of the listed formats. All of the 
fields in both columns are constantly active, 
and a change made to one value is immediately 
reflected in the values displayed in all the oth-
ers. 

The Destination fields both display and control 
what the length of the selection will be after 
processing using the current settings. You can 
enter the length of the Destination file by dou-
ble-clicking the appropriate field in the Destina-
tion column. 

The controls below the bar line allow fine-tun-
ing of the time compression/expansion process. 
They include the Ratio, Crossfade, Min Pitch, 
and Accuracy sliders. 

Ratio Sets the destination length in relation to 
the source length. Moving the slider to the right 
increases the length of the destination file, 
while moving the slider to the left decreases its 
length. 

Crossfade Adjusts the crossfade length in milli-
seconds, allowing you to optimize performance 
of the Time Compression/Expansion according 
to the type of audio material being processed. 
(This plug-in achieves length modification by 
replicating or subtracting very small portions of 
audio material and very quickly crossfading be-
tween these alterations in the waveform of the 
audio material.)
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Crossfade length affects the amount of 
“smoothing” performed on audio material to 
prevent audio artifacts such as clicks. In general, 
small narrow-range time (length) changes re-
quire longer crossfades while larger changes in 
length require smaller crossfades. The disadvan-
tage to long crossfade times is that they smooth 
the signal, including any transients. While this 
can be desirable for audio material such as vo-
cals, it is not appropriate for material with sharp 
transients such as drums or percussion. 

The default setting for this parameter is Auto 
(full left), in which crossfade times are set auto-
matically, according to the percentage of 
change in length for the current process. This 
setting should be sufficient for most applica-
tions. However, by using this slider, you can 
manually adjust and optimize crossfade times if 
necessary. For audio material with sharper at-
tack transients, use smaller crossfade times. For 
audio material with softer attack transients, use 
longer crossfade times. 

Min Pitch Sets the minimum, or lowest, pitch 
that will be used in the plug-in’s calculations 
during the Time Compression/Expansion pro-
cess. The control has a range of 40 Hz to 1000 
Hz. 

This slider should be set lower when processing 
bass guitar or other instruments with a similarly 
low frequency range. Set this parameter higher 
when processing higher frequency range sounds 
or instruments.

Accuracy Prioritizes the processing resources al-
located to audio quality (Sound) or timing 
(Rhythm). Moving the slider towards “Sound” 
generally results in better sonic quality and 
fewer audio artifacts. Moving the slider towards 
“Rhythm” puts the emphasis on keeping the 
tempo consistent. 
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When you are working with audio loops, listen 
carefully and adjust the Accuracy slider until 
you find a setting that keeps timing solid within 
the region. If you don’t, start and end times may 
be precise, but the beats in rhythmic material 
may appear to be shuffled if too little priority is 
given to Rhythm.

Pitch Shift
The Pitch Shift plug-in allows you to adjust the 
pitch of any source audio file with or without a 
change in its duration. This is a very powerful 
function which essentially allows sounds to be 
transposed a full octave up or down in pitch 
with or without altering playback speed. 

Time Compression & Expansion settings 
created in version 4.x and later of Pro Tools 
for Windows are not compatible with later 
versions. importing a 4.x session into ver-
sion 5.x and later will cause settings to be 
lost.

Pitch Shift plug-in



Pitch Shift Parameters

In addition to the standard AudioSuite func-
tions, the Pitch Shift plug-in provides the fol-
lowing parameters: 

Gain Adjusts input level, in 10ths of a dB. Drag-
ging the slider to the right increases gain, drag-
ging to the left decreases gain. 

Coarse and Fine Adjust amount of pitch shift. 
The Coarse slider transposes in semitones (half 
steps). the Fine slider transposes in cents (hun-
dredths of a semitone). 

Time Correction Disabling this option has the ef-
fect of “permanently varispeeding” your audio 
file. The file’s duration will be compressed or ex-
tended according to the settings of the Coarse 
and Fine pitch controls. Altering a file in this 
way has little detrimental effect on the fidelity 
of audio files, whereas time correction can affect 
fidelity in a more pronounced way.

Ratio Adjusts the amount of transposition 
(pitch change). Moving the slider to the right 
raises the pitch of the processed file, while mov-
ing the slider to the left decreases its pitch. 

Crossfade Allows you to manually adjust the 
crossfade length in milliseconds to optimize 
performance of the Pitch Shift plug-in according 
to the type of audio material you are processing. 
This plug-in achieves pitch transposition by 
processing very small portions of the selected 
audio material and very quickly crossfading be-
tween these alterations in the waveform of the 
audio material. 

Crossfade length essentially affects the amount 
of “smoothing” performed on audio material to 
prevent audio artifacts such as clicks when the 
audio is looped to generate the desired pitch 
shift. In general, small narrow-range pitch 
changes require longer crossfades while larger 
transpositions require smaller crossfades. The 
disadvantage to long crossfade times is that they 
smooth the signal, including any transients. 
While this can be desirable for audio material 
such as vocals, it is not appropriate for material 
with sharp transients such as drums or percus-
sion. 

The default setting for this parameter is Auto 
(full left), in which crossfade times are set auto-
matically, according to the settings of the coarse 
and fine controls. This setting should be suffi-
cient for most applications. However, by using 
this slider, you can manually adjust and opti-
mize crossfade times if necessary. For audio ma-
terial with sharper attack transients, use smaller 
crossfade times. For audio material with softer 
attack transients, use longer crossfade times. 

Min Pitch Sets the minimum, or lowest, pitch 
that will be used in the plug-in’s calculations 
during the Time Compression/Expansion pro-
cess. The slider has a range of 40 Hz to 1000 Hz. 
By being able to control the minimum pitch, 
you can focus the Time Compression/Expan-
sion process for maximum efficiency—it all de-
pends on the audio’s spectral shape. 

This slider should be set lower when processing 
bass guitar or other instruments with a similarly 
low frequency range. Set this parameter higher 
when processing higher frequency range sounds 
or instruments.

Accuracy Prioritizes the processing resources al-
located to audio quality (Sound) or timing 
(Rhythm). Moving the slider towards Sound 
generally results in better sonic quality and 
fewer audio artifacts. Moving the slider towards 
Rhythm puts the emphasis on keeping the 
tempo consistent.
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When you are working with audio loops, listen 
carefully and adjust the Accuracy slider until 
you find a setting that keeps timing solid within 
the region. If you don’t, start and end times may 
be precise, but the beats in rhythmic material 
may appear to be “shuffled” if too little priority 
is given to Rhythm. 

Reference Pitch Activates a sine wave-based 
pitch generator which you can use as an audible 
reference when pitch-shifting audio material. 
This feature has the following parameters:

Note Adjusts the frequency of the reference tone 
in semitones (half steps).

Detune Provides finer adjustment of the fre-
quency of the reference tone in cents (100ths of 
a semitone).

Level Adjusts the volume of the reference tone 
in dB.

To use the reference pitch feature of the Pitch 
Shift plug-in:

1  Select the audio material you want to use as a 
pitch reference. Click the preview button to be-
gin playback of the selected audio.

2  Click the Reference Pitch button to activate 
the reference sine wave tone.

3  Adjust the Note and Detune settings to match 
the reference tone to the pitch of the audio play-
back. Adjust the level setting to change the rela-
tive volume of the reference tone. It may also be 
helpful to toggle the reference pitch on and off 
to compare pitch.

4  Select the audio material to be pitch shifted. 

5  Adjust the Coarse and Fine Pitch Shift con-
trols to match the pitch of the audio playback to 
the reference pitch.

6  Click Process to apply pitch shift to the selec-
tion. 
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chapter 6

DirectConnect
DirectConnect is a Macintosh-only plug-in that 
allows up to 32 separate audio channel outputs 
from compatible host-based applications, such 
as software-based synthesizers or samplers, to be 
independently routed, recorded, processed and 
mixed within the Pro Tools environment.

Once the outputs of your software synths and 
samplers are routed to Pro Tools, you can:

• Assign them to busses for plug-in processing

• Automate volume, pan, and plug-in parame-
ters

• Bounce-to-disk

• Take advantage of the audio outputs of your 
Digidesign audio interfaces

If you have downloaded DirectConnect 
from the Digidesign Web site, see “Install-
ing DirectConnect” on page 54 for installa-
tion instructions.
DirectConnect Requirements
To use DirectConnect, you will need: 

• A Pro Tools MIX or MIXplus System, or 
Pro Tools LE software running on a Digide-
sign-approved Pro Tools configuration

• DAE/DigiSystem INIT 5.01 or higher

• Pro Tools 5.01 or later on the Macintosh

• Third-party client software compatible with 
DirectConnect, such as:

• Tokyo from Koblo

• Retro AS-1, Unity DS-1, Voodoo, or Phrazer 
from Bitheadz

• Reaktor, Dynamo, or B4 from Native Instru-
ments

• Spark XL from TC Works

• Alkali from Audio Genetics

DirectConnect support is also under develop-
ment for other third-party companies. For avail-
ability please check with the manufacturer or 
the Digidesign Web site at:

www.digidesign.com
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DirectConnect and Track Count on 
TDM Systems

Each channel of audio transmitted through Di-
rectConnect uses the same amount of resources 
as a single audio track in Pro Tools. For example, 
if you are playing 48 disk tracks on a Pro Tools 
MIX System, that will leave 16 channels of au-
dio (16 mono, or 8 stereo) that can be used with 
DirectConnect. 

If you attempt to use more channels than are 
available with DirectConnect, you may encoun-
ter a DAE error -6042 (PCI bus too busy).

DirectConnect and Track Count on 
Pro Tools LE 

On Pro Tools LE-based systems, performance is 
determined by several factors, including host 
CPU speed, available memory, and buffer set-
tings. Digidesign cannot guarantee 32 simulta-
neous audio channel outputs with DirectCon-
nect on all computer configurations.

For the latest information on recommended 
CPUs and system configurations, please check 
the Digidesign Web site.

DirectConnect and DSP Resources
(TDM Systems Only)

Similar to some plug-ins, DirectConnect re-
quires a specific type of DSP chip (SRAM) to 
function; there are three of these particular DSP 
chips on a MIX Core card.
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When DirectConnect is in use, it takes up one of 
these DSPs and makes it unavailable for any 
other plug-ins.

DirectConnect and Other DAE 
Applications
DirectConnect will work with DAE-compatible 
applications other than Pro Tools, including se-
quencers from other third-party software com-
panies.

However, in order to use DirectConnect, you 
must be using version 5.01 or higher of DAE and 
DigiSystem INIT, and you must install the Di-
rectConnect files described in “Installing Direct-
Connect” on page 54.

Installing DirectConnect
To use DirectConnect, you must install the plug-
in description file for your software synth or sam-
pler. This file must reside in the “Plug-Ins” folder 
inside the DAE Folder.

DirectConnect also requires the following files, 
which are installed automatically with the 
Pro Tools software:

DirectConnect This plug-in file resides in the 
Plug-Ins folder inside the DAE Folder (which is 
in the System Folder).

You can use the Show DSP Usage window 
(available from the Pro Tools Windows 
menu) to see how much DSP is available on 
your system and how it is currently being 
used. For details, see the Pro Tools Reference 
Guide.

Contact your sequencer manufacturer for 
information on compatibility with Direct-
Connect.



Digidesign StreamManager This file resides in 
the Extensions folder inside the System Folder.

Using DirectConnect

Configuring the IAC Driver

To control your software synth in Pro Tools by 
MIDI, you may need to first configure the OMS 
IAC driver.

To configure the OMS IAC driver:

1  If it’s not already installed, install the OMS 
IAC driver. To do this, perform a “Custom In-
stall” from the OMS Installer.

2  Once the IAC driver is installed and you have 
restarted your computer, you’ll need to update 
your OMS Studio setup. In the OMS Setup appli-
cation, choose Studio > MIDI Cards and Inter-
faces.

3  Once the IAC driver appears in your Studio 
Setup, double-click its icon and rename one of 
the busses as desired. 

Contact the manufacturer to obtain the 
plug-in description file for your DirectCon-
nect-compatible software.

Renaming an IAC bus
Since in this example we’ll be connecting to the 
Tokyo software (from Koblo), we’ll rename the 
bus as “Tokyo.” 

4  Click OK.

5  Choose FIle > Save and then close OMS Setup.

Configuring the Software Synth

Next you’ll need to route the software synthe-
sizer’s audio output to DirectConnect, and as-
sign its MIDI control to the IAC bus. Following 
is an example for configuring the Tokyo soft-
ware for Koblo synths. 

To configure the Tokyo application for 
DirectConnect:

1  Launch the Tokyo application and select the 
desired synth from the Synths menu.

2  Choose File > Select Drivers. Set the Audio 
Driver to “DirectConnect” and the MIDI Driver 
to “OMS.” Click OK.

3  Choose Options > MIDI Setup. Set the Doc Bus 
to “Tokyo” and the Channel to 1, then click OK.

Drivers dialog in Tokyo application

MIDI Setup dialog in Tokyo application
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Configuring Pro Tools

Lastly, you’ll need to configure Pro Tools to con-
nect to your software synth through DirectCon-
nect and the IAC bus.

To configure Pro Tools for DirectConnect:

1  Launch Pro Tools and open a new or previ-
ously saved session.

2  Choose File > New Track and specify one Aux-
iliary Input (stereo) track, then click Create.

3  Choose File > New Track and specify one MIDI 
Track, then click Create.

4  In the Mix window, click on the new MIDI 
track’s Device/Channel Selector and select To-
kyo on channel 1.

5  In the Mix window, assign the DirectConnect 
plug-in to the Auxiliary Input track.

Some third-party products allow both mono 
and stereo outputs, while others use mono 
or stereo outputs exclusively. If you cannot 
instantiate a DirectConnect plug-in on a 
mono track, it is likely that it can only be 
used on stereo tracks. Conversely, if you 
cannot instantiate a DirectConnect plug-in 
on a stereo track, it is likely that it can only 
be used on a mono track.
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6  In the DirectConnect plug-in window, set the 
output to Tokyo Stereo Out 1-2.

7  Select MIDI > Keyboard Thru and record-en-
able the MIDI track. Play some notes on your 
MIDI controller to trigger the Koblo synth.

8  Assign additional plug-ins as desired for the 
Auxiliary Input track.

Recalling DirectConnect States

Provided your client software supports it, Di-
rectConnect lets you recall the patch settings for 
your software synth or sampler. Once you save 
and re-open your Pro Tools session, DirectCon-
nect will automatically recall the settings previ-
ously used. Pro Tools will even launch, if neces-
sary, your client software when opening a 
session that uses DirectConnect.

DirectConnect plug-in window

The Bypass button is not supported in the 
DirectConnect plug-in window.

If your client software is not running and 
you open a DirectConnect session, please 
allow for a short delay while Pro Tools lo-
cates and launches your client software.



appendix a

DSP Requirements for TDM Plug-Ins
The tables on the following pages show the total 
number of instances of each DigiRack TDM 
plug-in that can be powered by a single DSP 
chip on the Pro Tools 24 MIX card and the DSP 
Farm. DSP usage differs according to card type.

Though there are a total of 6 DSP chips on a 
Pro Tools 24 MIX card, certain plug-ins, such as 
the Mod Delays, require a specific type of DSP 
chip to function. The tables indicate the num-
ber of compatible chips per card for each plug-
in.

Plug-ins used in multi-mono format on greater-
than-stereo tracks require one mono instance 
per channel of the multi-channel audio format. 
A multi-mono EQ used on a Dolby 5.1 format 
track, for example, requires six mono instances 
since there are six audio channels in the Dolby 
5.1 format.
Because multi-channel versions of the Compres-
sor II, Limiter II, and Expander Gate II plug-ins 
are available for use on greater-than-stereo 
tracks, separate instance counts are given for 
those configurations. 

The tables that follow show theoretical 
maximum performance when no other 
plug-ins are sharing available DSP re-
sources. You will typically use more than 
one type of plug-in simultaneously.
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Table 1.   Maximum instances of real-time TDM plug-ins pe
DigiRack Plug-Ins Guide
r DSP chip for a Pro Tools 24 MIX card
Plug-In Mono Stereo LCR
Quad

&
LCRS

5.0
5.1
&

6.0

6.1
&

7.0
7.1

DSP 
chips per 
Mix card

EQ II (1-band) 63 31 21 15 12 10 9 7 6

EQ II (4-band) 28 14 9 7 5 4 4 3 6

Compressor II 20 13 8 7 6 5 4 4 6

De-esser 16 8 5 4 3 2 2 2 6

Limiter II 20 13 8 7 6 5 4 4 6

Gate II 31 21 10 7 6 5 4 3 6

Expander/
Gate II

19 15 11 10 9 8 7 7 6

Mod Delay (short) 33 16 3 2 2 1 1 1 5

Mod Delay
(slap)

16 8 3 2 2 1 1 1 5

Mod Delay 
(medium)

8 4 3 2 2 1 1 1 5

Mod Delay 
(long)

4 2 1 1 – – – – 5

Dither 28 14 9 7 6 4 4 3 6

Time Adjuster 63 31 21 15 12 10 9 7 3

Trim 63 31 21 15 12 10 9 7 6

Signal Generator 32 16 10 8 6 5 4 4 6



Table 2.   Maximum instances of real-time TDM plug-ins pe
r DSP chip for a DSP Farm card
Plug-In Mono Stereo LCR
Quad

&
LCRS

5.0
5.1
&

6.0

6.1
&

7.0
7.1

DSP chips 
per DSP 

Farm card

EQ II (1-band) 25 12 8 6 5 4 3 3 4

EQ II (4-band) 10 4 3 2 1 1 1 1 4

Compressor II 8 5 3 2 2 2 1 1 4

De-esser 6 2 1 1 – – – – 4

Limiter II 8 5 3 2 2 2 1 1 4

Gate II 16 10 5 4 3 2 2 2 4

Expander/
Gate II

8 6 3 3 2 2 2 2 4

Mod Delay (short) 10 5 3 3 2 2 2 2 4

Mod Delay
(slap)

5 2 1 1 1 – – – 4

Mod Delay 
(medium)

2 1 – – – – – – 4

Mod Delay 
(long)

– – – – – – – – –

Dither 12 6 4 3 2 2 1 1 4

Time Adjuster 23 11 9 7 5 5 4 3 4

Trim 29 15 10 7 6 5 4 3 4

Signal Generator 12 6 4 3 2 2 1 1 4
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appendix b

DSP Delays Incurred by TDM Plug-Ins

This table shows the delays inherent in each type of DigiRack TDM plug-in. Delays matter only if you 
use a real-time TDM plug-in on one channel of a stereo or multichannel signal but not the others. 
This can cause the channels to be out of phase.

Use the TimeAdjuster plug-in to compensate for these delays. See “TimeAdjuster” on page 39.
Table 3.  Samples of delay incurred by each real-time DigiR
ack TDM plug-in on MIX and DSP Farm cards
Plug-In Samples of delay on MIX cards Samples of delay on DSP Farm cards

EQ II (1-band) 4 4

EQ II (4-band) 4 4

Compressor II 4 4

De-esser 4 4

Limiter II 4 4

Gate II 4 4

Expander/Gate II 4 4

Mod Delay (short) 4 4

Mod Delay (slap) 4 4

Mod Delay (medium) 4 4

Mod Delay (long) 4 n/a

Procrastinator n/a 3

Dither 4 4
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Time Adjuster 4 4

Signal Generator 4 4

Table 3. (Continued)Samples of delay incurred by each real-time DigiRack TDM plug-in on MIX and DSP Farm cards

Plug-In Samples of delay on MIX cards Samples of delay on DSP Farm cards
DigiRack Plug-Ins Guide



A
Accuracy parameter 50, 51
adjusting EQ 25
Attack parameter 28, 29
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menu 17
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DC Offset Removal 48
Duplicate 45
Gain 47
Invert 45
Normalize 46
Pitch Shift 50
Reverse 47
Time Compression/Expansion 49
using 23

AudioSuite processing on networked hard drives 
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AudioSuite window 18
Audition pop-up menu 20
auditioning an EQ 25
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Auto Touch mode 13
creating 13
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Write Safe button 9
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buffer size for AudioSuite processing 22
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C
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parameters 27
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De-esser plug-in 33
parameters 33

delay
DSP induced 5, 40, 41

Delete Current Settings File command 14
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destination folder for plug-in settings 15
Digidesign StreamManager file 55
DirectConnect
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client software 56
DSP resources 54
installing 54
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recalling states 56
requirements 53
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Compressor II 27
De-esser 33
Expander/Gate II 31
Gate II 30
Limiter II 29
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